10Versuch Nr. 8

10.1 Anmerkungen zum Versuch Nr. 8

Waéhrend der letzten 4 Versuche haben Sie sich mit dem detaillierten Rechner-Entwurf
besché&ftigt. Im letzten Versuch konnten Sie abschlief3end einen kleinen Rechner entwerfen,
der grundlegende Funktionen, wie Addition, Subtraktion und Multiplikation durchfihren
konnte.

Um nun einen tieferen Einblick in den Rechneraufbau zu bekommen, werden Sie sich in den
letzten drel Versuchen des Praktikums mit der Programmierung eines Mikroprozessors und
dem Umgang der entsprechenden Entwicklungsumgebung beschéftigen. Der Mikroprozessor,
der in diesen Versuchen behandelt wird, ist der PIC17C43. Im Versuch 8 werden Sie reine
Softwareprogramme  schreiben, in den Versuchen 9 und 10 missen Sie eine
Hardwareanbindung realiseren. Im Anhang von diesem Kapitel befindet sich eine
Beschreibung des PIC17C43 und der Entwicklungsumgebung (Software, Emulator u.s.w.).
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10.1.1 Einfdhrung in die Entwicklung von Programmen und Hardware mit
dem PIC17C4X

Die Programme, die ein Mikroprozessor ausfihren soll, werden normalerweise in das interne
ROM des Mikroprozessors gebrannt, welches zumeist nur einmal beschreibbar ist. Um nun in
der Entwicklungsphase nicht mehrere Bausteine brennen zu miissen - die man dann ja nicht
mehr verwenden konnte - steht dem Anwender Soft- und Hardware zur Entwicklung zur
Verfligung, wie unten in der Abbildung zu sehen ist.

Auf dem PC entwickelt der Anwender die Assenbl er pr ogr anme, in Form eines ASCII-
Files. Am PC ist ein sogenannter Enmul at or - Pod und ei ne Pr obe angeschlossen, die
den eigentlichen Prozessor ersetzen, und diesen emulieren. An der Emulator-Probe ist die
richtige Schaltung, in welche der Prozessor normalerweise eingesetzt wird, Uber ein Kabel
angeschlossen. Das Kabel ist genau an der Stelle angeschlossen, wo der echte Prozessor sitzen
soll.

Per Software (MPLAB) auf dem PC kann man nun seine Assembler-Programme Ubersetzen
und schliefdich testen !

in-LUine
O SVDC Power Supply ],__ < 90 - 250 VAC
) (Optional)
Windows 3.x | ©

1 Power Switch
Power Connector

Interchangeable

" PC Bus Emulater Probe

PC-Interface TTTTTTTTE

Common Interface Card PICMASTER Emulator Pod

PC Compatible Computer

Logic Probes

10.2 Literaturhinweis zu Versuch Nr. 8

Microchip Data Book, 1994
Microchip Embedded Control Book, 1995
Michael Rose: Mikroprozessor PIC17C42, Architektur und Applikation
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10.3 Aufgabenstellung vor Versuchsdurchfiihrung

Lesen Sie sich genau den Anhang zu diesem Versuch durch. Das Selbststudium des Anhangs
ist zwingend notwendig zur Durchfihrung der Aufgaben.

10.3.1

Bereiten Sie ein Additiorsprogramm fir zwei 16-Bit-Zahlen vor. Die Summanden sollen
schin zwe auf ei nander f ol genden Regi st er n ihrer Wahl befinden. Das Ergebnis
soll anPor t  C und D ausgegeben werden. Gehen Sie dabei wie folgt vor:

Skizzieren Sie ein Flussdiagramm, dem zu entnehmen ist, wie das Programm ablaufen
soll.

Schreilben Sie lhr Additionsprogramm unter der Verwendung des Befehlssatzes aus
Anhang 10.5.2. Dokumentieren Sie die Funktionalitét Ihres Programms ausreichend!

10.3.2

Bereiten Sie en Multiplikationsprogramm  fir zwei  8-Bit-Zahlen vor. Die
Mul ti pli kanden sollen sichin zwei auf ei nander f ol genden Regi st ern ihrer
Wahl befinden. Das Ergebnis soll an Port Cund D ausgegeben werden. Gehen Sie dabei

wie folgt vor:

Skizzieren Sie ein Flussdiagramm, dem zu entnehmen ist, wie das Programm ablaufen
soll.

Schreiben Sie lhr Multiplikationsprogramm unter der Verwendung des Befehlssatzes aus
Anhang 10.5.2. Verwenden Sie jedoch nicht den vorhandenen Multiplizier-Befehl.
Dokumentieren Sie die Funktionalitét Ihres Programms ausreichend!
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10.4 Versuchsdurchfiihrung

ACHTUNG  ACHTUNG  ACHTUNG ! ACHTUNG  ACHTUNG ! ACHTUNG !

Bel der Entwicklung und dem Testen der Anwenderschaltungen und der Programme beachten
Sie bitte folgendes zur Stromversorgung der einzelnen Komponenten:

Einschalten der Stromversorqung;

Schalten Sie zunéchste Ihren PC ein.

Schalten Sie dann den Emualtor-Pod auf dessen Riickseite auf externe Versorgung ein.
Schalten Sie dann die Anwenderschaltung ein.

Starten Sie die entsprechende Software.

Ausschalten der Stromversorgund:

Das Ausschalten der einzelnen Komponenten geschieht in umgekehrter Reihenfolge:

Verlassender Software.

Ausschalten der Anwenderschaltung.
Ausschalten des Emulator-Pods.
Ausschalten des PCs.

Gehen Sie bitte auch achtsam mit der offenliegenden Emulator-Probe um !

ACHTUNG ! ACHTUNG  ACHTUNG ' ACHTUNG  ACHTUNG ! ACHTUNG !

Verwendete Ger ate: 1 PC inkl. Assembler
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104.1

Arbeiten Sie zundchst das Tutorial fur die Software MPLAB aus Anhang 10.5.6 durch,
um ein besseres Verstandnis fir die Entwicklungsumgebung zu bekommen.

Achten Sie dabei auf folgendes:

Bel der Einstellung des Devel opnent - Modes (Meni Options ->
Devel opnent Mode) sollte das folgende eingestellt sein:

Development Mode
Configuration ] Power ] Pins : ] Break Options k
Tools ]'F‘ults_ ] Clock ] Memory 3

~ None (Editor Only) | Processor:| PIC17C43, Probe 178 ¥ |

- MPLAB-5IM Simulator | [Minor emulation limitations exist for ﬂ

MPLABR-ICE Emulat thiz device.
- MO 1 Click 'Details® for additional
“+ PICMASTER Emulator | |infomation.

IR

> MPLAB-ICD Debugger Inquire I Details._. I

0K | cancel | Apply |  Hen |
und
. .. .. . . B ——
Development Mode
Configuration ] Power ] Pins ] Break Ophions 1
Tools ] Ports. ] Clock | Memory .
170 Port: 300 =]

1] 4 Cancel Apply Help

Ilhre Dateien sollten in  folgendem Verzeichnis abgespeichert werden:
c:\labor\versuch8
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10.4.2

Geben Sie nun lhr entworfenes Additionsprogramm aus 10.3.1 wie im Tutorial
beschrieben mit der Software MPLAB ein. Dokumentieren Sie Ihr Assembler-File
ausreichend. Speichern Se ihre Assembler-File unter
c:\l abor\versuch8\ add. asm ab.

Lassen Sie Ihr Programm laufen (Run) bzw. Steppen Sie Schritt fur Schritt jede
Befehlszeile Ihres Programms durch, damit Sie nachvollziehen kénnen, was im Inneren
des Prozessor geschieht. Betrachten Sie sich dazu die folgenden Fenster: Pr ogr am
Menory Wndow, Special Function Register Wndow und File
Regi ster W ndow.

Geforderte Dokumentation:

Ausdruck des Assembler-Files.

Ausdruck der folgenden Fenster nach erfolgreicher Ausfihrung des Programms:
Program Menory W ndow, Special Function Register Wndow
und Fil e Regi ster W ndow.

10.4.3

Geben Sie nun Ihr entworfenes Multiplikationssprogramm aus 10.3.2 wie im Tutorial
beschrieben mit der Software MPLAB ein. Dokumentieren Sie Ihr Assembler-File
ausreichend. Speichern Se ihre Assembler-File unter
c:\l abor\versuch8\ nmul.asm ab.

Lassen Sie Ihr Programm laufen (Run) bzw. Steppen Sie Schritt fir Schritt jede
Befehlszeile Ihres Programms durch, damit Sie nachvollziehen kénnen, was im Inneren
des Prozessor geschieht. Betrachten Sie sich dazu die folgenden Fenster:  Pr ogr am
Menory Wndow, Special Function Register Wndow und File
Regi ster W ndow.

Geforderte Dokumentation:

Ausdruck des Assembler-Files

Ausdruck der folgenden Fenster nach erfolgreicher Ausfihrung des Programms:
Program Menory W ndow, Special Function Register Wndow
und Fil e Regi ster Wndow.
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10.5 Anhang zu Versuch Nr. 8

10.5.1 Datenblattauszug des PIC17C4X

MICROCHIP

~ PIC17C4

High-Performance 8-Bit CMOS EPROM Microcontroller

Devices Included In This Data Sheet

e PIC17C42

* PIC17C43

« PIC17C44

High-Performance RISC-like CPU Features

= Only 58 single word instructions to learn

« All single cycle instructions (160 ns) except for program
branches which are two-cycle and tabie reads/writes
Operating speed:

- DC - 25 MHz clock input

- DC - 160 ns instruction cycle

PACKAGE TYPES
PDIP, Windowed CERDIP
voo —={J 1 N 40 [J =—= RDO/ADB
ACO/ADO =[] 2 39 [J +—= RO1/ADY
ACH/ADT ==={]3 38 [J =—= RDYAD10
RC2/AD2 ==} 4 37 [J =+ RDYAD11
RCYAD3 =—=[] 5 36 [J =—=AD#ADI2
RC4/ADs =—=0] 6 25 [J ~—=RDY/ADI3
RCS/ADS =—={] 7 o 34 [J == ROG/AD14
RCE/ADE ~—={] 8 = 33 [J ~—=RD7/AD1S
RCT/ADT == 9 o 22 [ =——RCTRVer
vss —={} 10 :“ 31 {J w——VsS
ABO/CAPT =—=-{] 11 o 30 [ ~—= REG/ALE
RBI/CAP2 ===} 12 o 29 (J = RE1/OE
RBZ/PWM! <—e(1 13 x 28 {J == REZWH
RBAYPWMZ =[] 14 27 {1 =——TEST
RBATCLK12 =0 15 26 [ =——RAGINT
RBS/TCLKA =] 18 25 {1 ~——RA1TOCK!
RBE =[] 17 24 [J =~—=RA2
A87 =] 18 23 [J »—=RA3
OSC1/CUCN ~—=[] 19 22 [J +—= RA4RXDT
OSCH/CLKOUT =——(] 20 21 [ == RASTWCK

Device ':;::r::: Data Memory
PIC17C44 8K 454
PIC17C43 4K 454
PIC17C42 2K 232

8 x 8 Hardware Multiplier (PIC17C43/C44 Devices only)
Interrupt capability
16 levels deep hardware stack
Direct, indirect and relative addressing modes
Intermal/Extemal program memory execution
64K x 16 addressable program memory space
Peripheral Features
» 33 I/O pins with individual direction controi
* High current sink/source for direct LED drive
- RA2 and RA3 are open coliector, high voitage
(12V), high current (60 mA), I/O
» Two capture inputs and two PWM outputs
- Captures are 16-bit, max resolution 160 ns
- PWM resolution is 1- to 10-bit
* TMRO: 16-bit timer/counter with 8-bit programmable
prescaler
TMR1: 8-bit timer/counter
TMR2: 8-bit timer/counter
TMR3: 16-bit timer/counter
Serial Communications Interface (SC/USART)
Special microcontroller features
« Power-On Reset (POR), Power-Up Timer (PWRT) and
Oscillator Start-Up Timer (OST)
Watchdog Timer (WDT) with its own on-chip RC oscilla-
tor for reliabte operation
« Code-protection
+ Power saving SLEEP mode
« Selectable osciliator options
CMOS Technology
 Low-power, high-speed CMOS EPROM technology
* Fully static design
« Wide operating voltage range (2.5V to 6.0V)
« Commercial and Industrial Temperature Range
* Low-power consumption
- <5mMA @5V, 4MHz
- 100 pA typicai @ 4.5V, 32 kHz
- <1 pAtypical standby current @ 5V

LI S R S }

PLCC

RBA/TCLKIZ = []17

98y - g

i8d - Qo2

EXOLSEY = Og)

40]) -~ RDYAD11

39 {J e RD4/ADI2

DOOWIVH —= Q2
INvd —+ Qg2

QFP

s~ PIC17CAX

RD7/AD1S = CTILI 8
ADG/AD14 e TT19
ADS/ADIS ——e CIT] 10
RO4/AD12 === IO 11

igvead - CIOd e

34 [T <= RBS/TCLKD

33 {TT) = RB4TCLKI2

23 I w-e ACA/ADA

eqveoy - I 22
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PIC17CXX FAMILY OF DEVICES
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The Code Protect Feature is different from the PIC17C42.

Note 1:

2: RA2 and RAS3 can sink up to 60 mA.
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3.0 ARCHITECTURAL OVERVIEW

The high performance of the PIC17C4X can be attrib-
uted to a number of architectural features commonly
found in RISC microprocessors. To begin with, the
PIC17C4X uses a modified Harvard architecture. This
architecture has the program and data accessed from
separate memories. So the device has a program
memory bus and a data memory bus. This improves
bandwidth over traditional ven Neumann architecture,
where program and data are fetched from the same
memory (accesses over the same bus). Separating
program and data memory further aliows instructions to
be sized differently than the 8-bit wide data word.
PIC17C4X opcodes are 16-bits wide, enabling single
word instructions. The full 16-bit wide program memory
bus fetches a 16-bit instruction in a single cycle. A two-
stage pipeline overlaps fetch and execution of instruc-
tions. Consequently, all instructions execute in a single
cycle (160 ns @ 25 MHz), except for program branches

. and two special instructions that transfer data between
program and data memory.

The PIC17C4X can address up to 64K x 16 of program
memory space. The PIC17C42 integrates 2K x 16
EPROM program memory on-chip, while the PIC17C43
integrates 4K x 16 and the PIC17C44 integrates
8K x 16 EPROM program memory. Program execution
can be internal only (microcontrolier or protected mirco-
controller mode), external only (microprocessor mode)
or both (extended microcontroller mode).

The PIC17CXX can directly or indirectly address its
register files or data memory. All special function regis-
ters, including the Program Counter (PC) and Working
Register (WREG), are mapped in the data memory.
The PIC17CXX has an orthogonal (symmetrical)
instruction set that makes it possible to carry out any
operation on any register using any addressing mode.
This symmetrical nature and lack of ‘special optimal sit-
uations’ make programming with the PIC17CXX simple
yet efficient. In addition, the leaming curve is reduced
significantly.

One of the PIC17CXX family architectural enhance-
ments from the PIC16CXX family allows two file regis-
ters to be used in some two operand instructions. This
allows data to be moved directly between two registers
without going through the WREG register. This
increases performance and decreases program mem-
ory usage.

The PIC17CXX devices contain an 8-bit ALU and work-
ing register. The ALU is a general purpose arithmetic
unit. It performs arithmetic and Boolean functions
between data in the working register and any register
file.

The ALU is 8-bits wide and capable of addition, sub-
traction, shift and logical operations. Uniess otherwise
mentioned, arithmetic operations are two's comple-
ment in nature.

The WREG register is an 8-bit working register used for
ALU operations.

The PIC17C43 and PIC17C44 devices also have an
8 x 8 hardware muitiplier. This muitiplier generates a
16-bit result in a single cycle.

Depending on the instruction executed, the ALU may
affect the values of the Carry (C), Digit Carry (DC), and
Zero (Z) bits in the STATUS register. The C and DC bits
operate as a borrow and digit borrow out bit, respec-
tively, in subtraction. See the SuUBLW and SUBWF
instructions for examples.

Although the ALU does not perform signed arithmetic,
the Overflow bit (OV) can be used to implement signed
math. Signed arithmetic is comprised of a magnitude
and a sign bit. The overflow bit indicates if the magni-
tude overflows and causes the sign bit to change state.
Signed math can have greater than 7-bit values (mag-
nitude), if more than one byte is used. The use of the
overflow bit only operates on bit6 (MSb of magnitude)
and bit7 (sign bit) of the value in the ALU. That is, the
overflow bit is not useful if trying to implement signed
math where the magnitude, for example, is 11-bits. If
the signed math values are greater than 7-bits (15-, 24-
or 31-bit), the algorithm must ensure that the low order
bytes ignore the overflow status bit.

Care should be taken when adding and subtracting
signed numbers to ensure that the correct operation is
executed. Example 3-1 shows an item that must be
taken into account when doing signed arithmetic on an
ALU which operates as an unsigned machine.

EXAMPLE 3-1: SIGNED MATH
Signed Math Unsigned Math
~127 {FFh) 255 (Frh)
+ 1 (0lh) + 1 (01h)
= -126 (FEh) = 0 (00h) ; C =1

Signed math requires the result in REG to
be FEh (-126). This would be accomplished
by subtracting one as opposed to adding
one.

Simplitied block diagrams are shown in Figure 3-1 and

Figure 3-2. The descriptions of the device pins are
listed in Table 3-1.
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PIC17C43 AND PIC17C44 BLOCK DIAGRAM

“

FIGURE 3-2
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microprocessor mode or extended microprocessor mode
or extended microcontrolier mode. in multiplexed system

bus configuration these pins are address output as well

as data input or output.
In microprocessor or extended microcontroller mode, it is

in microprocessor mode or extended microcontroller
the Output Enable (OF) control output (active low).

mode, it is the Address Latch Enable (ALE) output.

This is also the upper byte of the 16-bit system bus in
In microprocessor or extended microcontroller mode, it is

the Write Enable (WR) control output (active low).

Address should be latched on the falling edge of ALE
ST | Test mode selection control input. Always tie to Vss for nor-

output.
Ground reference for logic and I/O pins.

PORTD is a bidirectional I/O Port.
PORTE is a bidirectional I/O Port.
Positive supply for logic and I/O pins.

Description
mal operation.

TTL
TTL
TTL

/0 | TTL

Type | Type
/0 | TTL
/0
vo | TTL
Vo | TTL
|

/0
[1{e]
P

No.
10
9
3
2
5, 6,
27,28
16, 17

No.
43
42
41
40
39
38
37
36
32
31
30
29
11,
12,
33, 34
1,44

PIC17C4X PINOUT DESCRIPTIONS (CONT.)

DIP |PLCC| QFP |/O/P | Buffer

No.
40
39
38
37
36
35
34
33
30
29
28
27
10,
31
1

Name

TABLE 3-1
RDO/AD8
RD1/AD9
RD2/AD10
RD3/AD11
RD4/AD12
RD5/AD13
RD6/AD14
RD7/AD15
REO/ALE
RE1/OE
RE2/WR
TEST

Vss

VDD
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3.1 Clocking Scheme/instruction Cycle

The clock input (from OSC1) is internally divided by
four to generate four non-overlapping gquadrature
clocks, namely Q1, Q2, Q3 and Q4. Internally, the pro-
gram counter {2 = incremented every Q1, and the
instruction is fercnea from the program memory and
latched into the instruction register in Q4. The instruc-
tion is decoded and executed during the following Q1
through Q4. The clocks and instruction execution flow

are shown in Figure 3-3.

3.2 Instruction F Pipelinin

An “Instruction Cycle” consists of four Q cycles (Qf,
Q2, Q3 and Q4). The instruction fetch and execute are
pipelined such that fetch takes one instruction cycle
while decode and execute takes another instruction
cycle. However, due to the pipeiining, each instruction
effectively executes in one cycle. If an instruction
causes the program counter to change (e.g. GOTo) then
two cycles are required to complete the instruction (see
Example 3-2).

A fetch cycle begins with the program counter incre-
menting in Q1.

In the execution cycle, the fetched instruction is latched
into the “Instruction Register (IR)” in cycle Q1. This
instruction is then decoded and executed during the
Q2, Q3, and Q4 cycles. Data memory is read during Q2
(operand read) and written during Q4 (destination
write).

FIGURE 3-3: CLOCK/INSTRUCTION CYCLE
"Q1 | Q| Q3| Q4 Q1| Q2[Q3| Q41 Q| Q| Q] QI
0SC1 .
Q1 y— — — J
Qzy ™\ } VAN } VA — | imemat
Q3 T — /WY -
Q4 \_ P T
PC B FCE Puoly] l
oscaeclkoutr\ 000 e
(RC mode) | _ | i
Fo IN: 1
! xacute | -1) Feich 1) |
. o RO —
+
EXAMPLE 3-2: INSTRUCTION PIPELINE FLOW
1. MOVILW 55h i Execute 1
g . ggngF gORTxls Fetch 2 Execute 2
. UB__
4. BSF PORTA, BIT3 Ferch 3 Execute 3
Fetch 4 Flush
Fetch SUB_1
All instructions are single cycle, except for any program branches, These take two cycles since the fetch
instruction is “flushed” from the pipeline while the new instruction is being fetched and then executed.
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4.0 RESET

The PIC17CXX differentiates between various kinds of
reset:

» Power-On Reset (POR)

» MCTR reset during normal operation

¢ WDT time-out reset during normal operation

Some registers are not affected in any reset condition;
their status is unknown on POR and unchanged in any
other reset. Most other registers are reset to a “reset
state” on Power-On Reset (POR), on MCLR or WDT
reset during normal operation and on MCLR reset dur-
ing SLEEP. They are not affected by a WDT reset dur-
ing SLEEP, since this reset is viewed as the resumption
of normal operation. The TO and PD bits are set or
cleared differently in different reset situations as indi-
cated in Table 4-3. These bits are used in software to
determine the nature of reset. See Table 4-4 for a full
description of reset states of ail registers.

4.1 Power-On PO r-U
imer (PW! n ill X

Timer (OST)
411 POWER-ON RESET (POR)

The Power-On Reset circuit holds the device in reset

until Vop is above the trip point (in the range of 1.4V -

2.3V). PIC17C43 and PIC17C44 will produce an inter-

nal reset for both rising and falling Voo. The PIC17C42

does not produce an internai reset when VDD declines®
To take advantage of the POR, just tie the MCLF/Vep

pin directly (or through a resistor) to Voo. This will elim-

inate external RC components usuaily needed to cre-

ate Power-On Reset. A minimum rise time for Vop is

required. See Electrical Specifications for details.

412 POWER-UP TIMER (PWRT)

The Power-Up Timer provides a fixed 96 ms time-out
(nominal) on power-up. This occurs from rising edge of
the POR signal and after the first rising edge of MCLR
(detected high). The Power-up timer operates on an
internal RC oscillator. The chip is kept in RESET as
long as the PWRT is active. In most cases the PWRT
delay allows the VoD to rise to an acceptable level.
The power-up time delay will vary from chip to chip and
o VDD and temperature. See DC parameters for
details.

4.1.3  OSCILLATOR START-UP TIMER (OST)

The Oscillator Start-Up Timer (OST) provides a 102_4
oscillator cycle (1024 Tosc) delay after MCLR is
detected high or a wake-up from SLEEP event occurs.
The OST time-out is invoked only for XT and LF oscil-
lator modes on a Power-On Reset or a Wake-Up from
SLEEP.

The OST counts the oscillator pulses on the OSC1/
CLKIN pin. The counter only starts incremgnting _after
the amplitude of the signal reaches the oscxlla‘tor input
thresholds. This delay allows the crystal oscillator or
resonator to stabilized before the device exits reset.
The length of time-out is a function of the crystal/reso-

nator frequency.

414  TIME-OUT SEQUENCE

On power-up the time-out sequenca is as follows: First
the intemal POR signal goes high when the POR trip
point is reached. If MCLR is high, then both the OST
and PWRT timers start. In general the PWRT time-out
is longer, except with low frequency crystals/resona-
tors. The total time-out also varies based on oscillator
configuration. Table 4-1 shows the times that are asso-
ciated with the oscillator configuration. Figure 4-2 and
Figure 4-3 display these time-out sequences.

If the device voltage is not within electrical specification
at the end of a time-out, the MCLR/VrP pin must be
held low until the voitage is within the device specifica-
tion. The use of an external RC delay is sufficient for
many of these applications.

The time-out sequence begins from the first risi
o . ng edge

TABLE4-1:  TIME-OUT IN VARIOUS
SITUATIONS

Oscillator Power-up
Configuration

XT, LF Greater of | 1024 Tosc
(96 ms,
1024 Tosc)

EC,RC Greater of
(96 ms,
1024 Tosc)

TABLE4-2:  STATUS BITS AND THEIR
SIGNIFICANCE

ub' PD ! Event

1 1 |Power-On Reset, MCLR reset during normal
| operation, or CLRWDT instruction executed
1 ‘ 0 |MCLR reset during SLEEP or interrupt wake-
| up from SLEEP
u I , WDT reset during normal operation
u | o | WOT time-out wake-up from SLEEP

In Figure 4-2, Figure 4-3 and Figure 4-4, TpwrT >
TosT, as would be the case in higher frequency crys-
tals. For lower frequency crystals, (i.e., 32 kHz) TosT
would be greater.

Table 4-3 shows the reset conditions for some special
registers, while Table 4-4 shows the initialization condi-
tions for all the registers. The shaded registers (in
Table 4-4) only exist for PIC17C43 and PIC17C44
devices. In the PIC17C42, the PRODH and PRODL
registers are general purpose RAM.
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TABLE 4-3: RESET CONDITION FOR THE PROGRAM COUNTER AND THE CPUSTA REGISTER

Event PCH:PCL CPUSTA OST Active

Power-On Resst 0000h --11 11-- Yes
MCLR reset during normal operation 0000h --11 11-- No
MCLR reset during SLEEP 0000h --11 10-- Yes 2
WDT reset during normal operation 0000h --11 01~~ No
WDT during SLEEP 0000h --11 00-~ Yes 2
Interrupt wake-up from SLEEP | GLINTD is set PC+1 --11 10-- Yes 2

GLINTD is clear PC+1! -~10 10-- Yes 2
Legend: u = unchanged, x = unknown, - = unimplemented, reads as '0".

Note 1: On wake-up, this instruction is executed. The instruction at the appropriate interrupt vector is fetched and
then executed.
2: The OST is only active when the Oscillator is configured for XT or LF modes.

FIGURE 4-2: TIME-OUT SEQUENCE ON POWER-UP (MCLRTIED TO VDD)

Voo

MCLR .
INTERNAL POR —————-—j

ra———— TPWRT ——"

PWRT TIME-OUT s

OST TIME-QUT

'

FIGURE 4-3: TIME-OUT SEQUENCE ON POWER-UP (MCLR NOT TIED TO Vop)
Voo ———/

MCLR

INTERNAL POR _—____f

INTERNAL RESET

PWRT '
PWATTMEGUT v J
SSTTWEDUT [
TERNAL RESET |
FIGURE 4-4: SLOW RISE TIME (MCLR TIED TO VpD)
. 5V

Voo oV L1V
MCTR T
INTERNAL POR ————-JV

N TPWRT ! .
PWATTIME-OUT : i
— ‘wa— TOST
O3TTIME-OU *
INTERNATRESET I
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5.0 INTERRU PTS
The PIC17C4X devices have 11 sources of interrupt:

Extemal interrupt from the RAO/INT pin
Change on RB<7:0> pins

Timer0 Overflow

Timer1 Overflow

Timer2 Overflow

Timer3 Overflow

SCI Transmit buffer empty

SC! Receive buffer full

Capture1

Capture2

TOCK! edge occurred

There are four registers used in the control and status
of interrupts. These are:

CPUSTA

INTSTA

PIE

PIR

The CPUSTA register contains the GLINTD bit. This is
the Global interrupt Disable bit. When this bit is set, all
interrupts are disabled. This bit is part of the controlier
cora functionality and is described in the Memory Orga-
nization section.

FIGURE 5-1: INTERRUPT LOGIC

When an interrupt is rdsponded 1o, the GLINTD bit is
automatically set to disable any further interrupt, the
return address is pushed onto the stack and the PCis
loaded with the interrupt vector address. There are four
interrupt vectors. Each vector address is for a specific
interrupt source (except the peripheral interrupts which
have the same vector address). These sources are:

« Extemal interrupt from the RAO/INT pin
« Timer0 Overflow

« TOCKI edge occurred

« Any peripherai interrupt

When program execution vectors to one of these inter-
rupt vector addresses (except for the peripheral inter-
rupt address), the interrupt flag bit is automatically
cleared. Vectoring to the peripheral interrupt vector
address does not automatically clear the source of the
interrupt. In the peripheral interrupt service routine, the
source(s) of the interrupt can be determined by testing
the interrupt flag bits. The interrupt flag bit(s) must be
cleared in software before re-enabling interrupts to
avoid infinite interrupt requests.

All of the individual interrupt flag bits will be set regard-
less of the status of their corresponding mask bt or the
GLINTD bit.

For external interrupt events, there will be an interrupt
latency. For two cycle instructions, the latency could be
one instruction cycle longer.

The “return from interrupt” instruction, RETFIE, can be
used to mark the end of the interrupt setvice routine.
When this instruction is executed, the stack is
“POPed", and the GLINTD bit is cleared (to re-enable
interrupts).

TMRLIF
TMR1IE
TMR2IF
Trsie 1
TMRSIF
TMRSIE

RCIF
RCIE
RBIF
RBIE

Wake-up (if in SLEEP mode
or terminate long write

Interrupt to CPU
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5.1

Interrupt Status Register (INTSTA)

The Interrupt Status/Control register (INTSTA) records Note:
the individual interrupt requests in flag bits, and con- e
tains the individual enable bits (not for the peripherals).
The PEIF bit is a read only, bit wise OR of all the periph-
eral flag bits in the PIR register (Figure 5-4).

TOIF, INTF, TOCKIF; or PEIE will be set by

FIGURE 5-2: INTSTA REGISTER (ADDRESS: 07H, UNBANKED)

R-0

RW-0 RW-0 -0 RW-0 RW-0

RW-0 RW-0 AW
["PEIF [TockiF] ToIF | INTF | PEIE [TocKIE[ TOIE | INTE | |R=Readable bit

bit7
bit 7:

bit 6:

bit 5:

bit 3:

bit 2:

bit 1:

bit O:

bitd W = Writable bit
- n = Value at POR reset

PEIF: Peripheral Interrupt Flag bit

This bit is the OR of all peripheral interrupt flag bits AND'ed with their corresponding enable bits.
1 = A peripheral interrupt is pending

0 = No peripheral interrupt is pending

TOCKIF: External Interrupt on TOCKI Pin Flag bit

This bit is cleared by hardware, when the interrupt logic forces program execution to vector (18h).
1 =The software specified edge occurred on the RA1/T OCKI pin

0 = The software specified edge did not occur on the RA1/TOCKI pin

TOIF: Timer0 Overflow Interrupt Fiag bit

This bit is cleared by hardware, when the interrupt logic forces program execution to vector (10h).
1 = Timer0 overflowed

0 = TimerO did not overflow

INTF: External interrupt on INT Pin Flag bit

This bit is cleared by hardware, when the interrupt logic forces program execution to vector (08h).
1 = The software specified edge occurred on the RAC/I NT pin

0 = The software specified edge did not occur on the RAO/INT pin

PEIE: Peripheral interrupt Enable bit

This bit enables all peripheral interrupts that have their corresponding enable bits set.
1 = Enabie peripheral interrupts

0 = Disable peripheral interrupts

TOCKIE: External Interrupt on TOCKI Pin Enable bit
1 = Enable software specified edge interrupt on the RA1/T OCKI pin
0 = Disable interrupt on the RA1/TOCKI pin :

TOIE: Timer0 Overflow Interrupt Enable bit
1 = Enable Timer0 overflow interrupt
0 = Disable Timer0 overflow interrupt

INTE: External Interrupt On INT Pin Enable bit
1 = Enable software specified edge interrupt on the RAU/INT pin
0 =Disable software specified edge interrupt on the RAO/INT pin

Skript zum Hardware-Praktikum
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5.2 ipheral interrupt Enable Register
(PIE)

This register contains the individual flag bits for the
Peripheral interrupts.

FIGURE 5-3: PIE REGISTER (ADDRESS: 17H, BANK 1)

RW-0 RW-0 RAW-0 R'W-0 R/'W-0 RW-0 RW-0 RW-0

[ RBIE_[TMR3IE[TMR2IE[TMR1IE[ CA2IE | CATIE| TXIE | RCIE |

bit 7: RBIE: PORTB Interrupt on Change Enabie bit
1 = Enable PORTB interrupt on change
0 = Disable PORTB interrupt on change

bit6:  TMR3IE: Timer3 Interrupt Enable bit
1 = Enable Timer3 interrupt
0 = Disable Timer3 interrupt

bit5:  TMR2IE: Timer2 Interrupt Enable bit
1 = Enable Timer2 interrupt
0 =Disable Timer2 interrupt

bit4:  TMR1IE: Timer1 Interrupt Enable bit
1 =Enable Timer1 interrupt
0 = Disable Timer1 interrupt

bit3:  CAZ2IE: Capture2 Interrupt Enable bit
1= Enable Capture interrupt on RB1/CAP2 pin
0 = Disable Capture interrupt on RB1/CAP2 pin

bit2:  CA1IE: Capturet Interrupt Enabie bit

1 =Enable Capture interrupt on RB2/CAP1 pin

0 =Disable Capture interrupt on RB2/CAP1 pin
bit1:  TXIE: SCI Transmit Interrupt Enable bit

1 = Enable Transmit buffer empty interrupt

0 =Disable Transmit buffer empty interrupt
bit0:  RCIE: SCI Receive Interrupt Enable bit

1 = Enable Receive buffer full interrupt
0 =Disable Receive buffer full interrupt

bit7 bitd

R = Readable bit
W = Writable bit
-n = Value at POR reset
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5.3 Peripheral Interrupt Request Register

(PIR)

This register contains the individual flag bits for the
peripheral interrupts.

These bits will be set by the specified-con-
. dition, even if the corresponding interrupt
enable bitis cleared (interrupt disabled), or
the GLINTD bit is:set (all. interrupts dis-

" ahled). Before enabling an interrupt, the
- usermay wish to clear the interrupt flag to

- ensure that the:program does not immedi-
. ately branchiathe pefipheral interrupt ser-
*“vice routine. ‘

Note:

FIGURE 5-4: PIR REGISTER (ADDRESS: 16H, BANK 1)

RW-0 RW-0 RW-0 RW-0 BRW-0 RW-0 R-1 R-0 :
[ RBIF_| TMR3IF | TMR2IF | TMRIIF] CA2IF | CA1IF | TXIF [ RCIF | | R =Readable bit
oit7 b0 |W= Writable bit
-n = Value at POR reset
bit7: RBIF: PORTB Interrupt on Change Flag bit .
1 =One of the PORTB inputs changed (Software must end the mismatch condition)
0 = None of the PORTB inputs have changed
bit6:  TMR3IF: Timer3 interrupt Flag bit
if Capture1 is enabled (CA1/PR3=1)
1 = Timer3 overfiowed
0 = Timer3 did not overflow
If Capture1 is disabled (CA1/PR3 =0)
1 = Timer3 value has rolled over to 0000h from equailing the period register (PR3H:PR3L) value
0 = Timer3 value has not rolied over to 0000h from equalling the period register (PR3H:PR3L) value
bit5:  TMRR2IF: Timer2 Interrupt Flag bit
1 =Timer2 value has rolled over to 0000h from equaliing the period register (PR2) value
0 = Timer2 value has not rolled aver 0 0000h from equalling the period register (PR2) value
bit4: TMR1IF: Timer1 Interrupt Flag bit
If Timert is in 8-bit mode (T16 = 0)
1 = Timer1 value has rolled over to 0000h from equalling the period register (PR) value
0 = Timer1 value has not rolled over to 0000h from equalling the period register (PR2) vaiue
if Timert is in 16-bit mode (T16 = 1)
1 = TMR1:TMR2 vaiue has rolled over to 0000h from equailing the period register (PR1 :PR2) value
0 = TMR1:TMR2 vaiue has not rolled over to 0000h from equaliing the period register (PR1 :PR2) value
bit3:  CA2IF: Capture2 Interrupt Flag bit
1 = Capture event occurred on RB1/CAP2 pin
0 = Capture event did not occur on RB1/CAP2 pin
bit2:  CA1IF: Capturel interrupt Flag bit
1 = Capture event occurred on RBO/CAP1 pin
0 = Capture event did not occur on RBO/CAP1 pin
pit1:  TXIF: SC! Transmit Interrupt Flag bit
1 = Transmit buffer is empty
0 = Transmit buffer is full
pit0:  RCIF: SCI Receive Interrupt Flag bit
1 = Receive buffer is full
0 = Receive buffer is empty
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54  inferrupt uperauon

Global interrupt Disable bit, GL_INTD (CPQSTA<4>),
enables all unmasked interrupts (if clear) or dlsaAbles ait
interrupts (if set). individual interrupts_ can be disabled
;hrough their corresponding enable bll§ in the INTSTA
register. Peripheral intern{p!s'need either the glopgl
peripheral enable PEIE bit disabled, or the specific
peripheral enable bit disabled. Dnsabhng thg peripher-
als via the global peripheral'enable bit, dlgables all
peripheral interrupts. GLINTD is set on reset (interrupts
disabled). - A
The RETFIE instruction allows returmpg from interrupt
and re-enable interrupts at the same time.

interrupt is responded to, the GLINTD bit is
g;?:r:aat;:;mly se:) to disable any further interrupt, th.e
return address is pushed onto the stack and tr.ne PCis
loaded with interrupt vector. There are four interrupt
vectors to reduce interrupt latency.
The peripheral interrupt vector has multiple interrupt

vew uN1 eTTUPY

The extemal interrupt on the RAO/INT pin is edge tng-
gered. Either the rising edge, if INTEDG _b_lt
(TOSTA<7>) is set, or the falling edge, if INTEDG brtA is
clear. When a valid edge appears on the RAO/INT pin,
the INTF bit (INTSTA<4>) is set. This interrupt can be
disabled by clearing the INTE control bit (INTSTA<0>).
The INT interrupt can wake the processor from SLEEP.
See Section 14.4 for details on SLEEP operation.

5.6 Inter

An overflow (FFFFh — 0000h) in TMRO will set the TQIF
(INTSTA<5>) bit. The interrupt can be enabled/dg-
abled by setting/clearing the TOIE control bit
(INTSTA<1>). For operation of the TMRO module, see
Section 11.0.

5.7 terrupt

ing of infor-
PUSH and
Tupt service
t were called.

, other registers may also

ation for an interrupt service routine. The

sources. Once in the peripheral interrupt sewige rou-
tine, the source(s) of the interrupt can bg detenpmed by
polling the interrupt flag bits. The peripheral interrupt
flag bit(s) must be cleared |n‘ soMre before re-
enabling interrupts to avoid continuous interrupts.

The PIC17C4X devices have 4 interrupt vectors. Thesg
vectors and their hardware priority are shown in
Table 5-1. If two enabled interrupts occur “at the same
time®, the interrupt of the highest priority will be ser-
viced first. This means that the vector address of that
interrupt will be loaded into the program counter (PC).

TABLE 5-1: INTERRUPT VECTORS/

The extemal interrupt on the RA1/TOCKI pin is edge
triggered. Either the rising edge, if the TOSE bit
(TOSTA<6>) is set, or the falling edge, if the TOSE bit is
clear. When a valid edge appears on the RA1/TOCK|
pin, the TOCKIF bit (INTSTA<65) is set. This interrupt
can be disabled by clearing the TOCKIE control bit
(INTSTA<2>). The TOCKI interrupt can wake up the
processor from SLEEP. See Section 14.4 for details on
SLEEP operation.

5.8 Peripherai Interrupt

The peripheral interrupt flag indicates that at least one

Example 5-1 shows the saving and restori
routine or could be subroutines tha

POP routines could either be in each inter
Depending on the application,

need to be saved, such as PCLATH.

m

During an interrupt, only the retumed PC value is saved

on the stack. Typically, users may wish to save key reg-
isters during an interrupt; .g. WREG, ALUSTA and the

BSR registers. This requires implementation in soft-

of the peripheral interrupts occurred (PEIF is set). The
PRIORITIES PEIF bitis a read only bit, and is a bit wise OR of all the
flag bits in the PIR register AND'ed with the corre-
Address Vector Pri.ority spgnding enable bits ingthe PIE register. Some of the
0008h Externat Interrupt on RA0/ .| 1 (Highest) peripheral interrupts can wake the processor from
INT pin (INTF) SLEEP. See Section 14.4 for details on SLEEP opera-
0010h | TMRO overflow interrupt 2 tion.
(TOIF)
0018h External Interrupt on TOCKI 3
(TOCKIF) @
0020h | Peripherals (PEIF) 4 (Lowest) 3: S

EXAMPLE 5-1: SAVING STATUS AND WREG IN RAM

; The addresses that are used to store the CPUSTA and WREG values

; must be in the data memory address range of 18h - 1Fh. Up to

; 8 locations can be saved and restored using

; the MOVFP instruction. This instruction neither affects the status
; bits, nor corrupts the WREG register.

PUSH MOVFP WREG, TEMP_W

; Save WREG

MOVFP ALUSTA, TEMP_STATUS ; Save ALUSTA

MOVFP BSR, TEMP_BSR i Save BSR
ISR t ; This is the interrupt service routine
POP MOVFP TEMP_W, WREG ; Restore WREG

MOVFP TEMP_STATUS, ALUSTA ; Restore ALUSTA

MOVFP TEMP_BSR, BSR i Restore BSR

RETFIE

Return from Interrupts enabled
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6.0 MEMORY ORGANIZATION

There are two memory blocks in the PIC17C4X; pro-
gram memory and data memory. Each block has its
own bus, so that access to each block can occur during
the same oscillator cycle.

The data memory can further be broken down into Gen-
oral Purpose RAM and the Special Function Registers
(SFRs). The operation of the SFRs that control the
«core” are described here. The SFRs used to control
the peripheral modules are described in the section dis-
cussing each individual peripheral module.

6.1 Program Memory Organization

PIC17C4X devices have a 16-bit program counter
capable of addressing a 84K x 16 program memory
space. The reset vector is at 0000h and the interrupt
vectors are at 0008h, 0010h, 0018h, and 0020h
(Figure 6-1).

6.1.1 PROGRAM MEMORY OPERATION

The PIC17C4X can operate in one of four possible
program memory configurations. The configuration is
selected by two configuration bits. The possible modes
are:

» Microprocessor
« Microcontroiler

« Extended Microcontroller
» Protected Microcontroller

The microcontroller and protected microcontroller
modes only allow intemal execution. Any access
beyond the program memory reads unknown data.
The protected microcontroller mode also enables the
eode protection feature.

The extended microcontroller mode accesses both the
internal program memory as weli as external program
memory. Execution automatically switches between
internal and external memory. The 16-bits of address
allow a program memory range of 64K-words.

The microprocessor mode only accesses the external
program memory. The on-chip program memory is
ignored. The 16-bits of address aliow a program mem-
ory range of 64K-words. Microprocessor mode is the
default mode of an unprogrammed device.

The different modes allow different access to the con-
figuration bits, test memory, and boot ROM. Table 6-1
lists which modes can access which areas in memory.
Test Memory and Boot Memory are not required for
normal operation of the device. Care should be taken to
ensure that no unintended branches occur to these
areas.

TABLE 6-1: MODE MEMORY ACCESS
. Internal Configuration Bits,
Operating Program Test Memory,
Mode Memory Boot ROM
Microprocessor Mo Access No Access
Microcontrolier Access Access
Extended Access No Access
Microcontrolier
thotected Access Access
Microcontroller

_SKrlpt zum Hardware-Praktikum

FIGURE 6-1: PROGRAM MEMORY MAP
AND STACK
[ PC<15:0> 1
CALL, RETURN 16

RETFIE, RETLW
Stack Levei 1

Stack Level 16

Reset Vector 0000
INT Pin Interrupt Vector 0008h
Timer0 Interrupt Vector 0010h
TOCKI Pin interrupt Vector | 0018h
Penpheral Interrupt Vector | 0020h
0021h
_________________ 7FFh
(17C42)
5
-
Eg
=8 | beeo L. FFFh
56 (17C43)
0
S
1FFFh
(17C44)
e FDFFh
FOSCO FEOCh
oa FOSC1 FEQ1h
= WDTPSO FEO2h
2 WDTPSt FEO3h
<3 PMO FEO4h
'(% 3 Reserved FEOSh
59 PM1 FEO6h
2 Reserved FEO7h
5 PM2 3 FEOBh
© FEOSh
4 Reserved FEOFh
FE1Oh
Test EPROM FF5Fh
FFE0h
Boot RCM
FFEFh

1 User memory space may be internal, external, or
both. The memory configuration depends on the
processor mode.

1 This location is reserved for the PIC17C42.

The PIC17C4X can operate in modes where the pro-
gram memory is offchip. They are the microprocessor
and extended microcontroller medes. The micropro-
cessor mode is the default for an unprogrammed
device.

Regardless of the processor mode, data memory is
always on-chip.
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FIGURE 6-2: MEMORY MAP IN DIFFERENT MODES

17C43/ | co0o 0000 0000
17C44
OFFF/FFF, OFFF/FFF
External 1000/ ! .—&
Program 2000 8
Memory &
Extamal ;
ram
Mr:r%ory é
3
EEFE FE0O [ Config, Bits | | £
FFEF Test EPROM &
FFFF
OFF-CHIP ON-CHIP OFF-CHIP ON-CHIP OFF-CHIP ON-CHIP
00 00 00
120D 120 120 us
Q
-3
FF 1FF FF 1FF FF 1FFD 2
=
OFF-CHIP ON-CHIP OFF-CHIP ON-CHIP OFF-CHIP ON-CHIP 5

6.1.2 EXTERNAL MEMORY INTERFACE

When either microprocessor or extended microcontrol-
ter mode is selected, PORTC, PORTD and PORTE
are configured as the system bus. PORTC and
PORTD are the multiplexed address/data bus and
PORTE is for the control signals. External components
are needed to demultiplex the address and data. This
can be done as shown in Figure 6-4. The waveforms
of address and data are shown in Figure 6-3. For com-
plete timings, please refer to the electrical specification
section.

FIGURE 6-3: EXTERNAL PROGRAM
MEMORY ACCESS
WAVEFORMS
,atlazlaeslas ailaezlaslas:arl
AD——(X X —
<15:0>  address out Data in ! Addressout Data out
ALEL___ /T \ /\ :
OE A .

As the speed of the processor increases, external
EPROM memory with faster access time must be
used. Table 6-2 lists extemal memory speed require-
ments for a given PIC17C4X device frequency.

In extended microcontroller mode, when the device is
executing out of internal memory, the control signals
will continue to be active. That is, they indicate the
action that is occurring in the internal memory. The
external memory access is ignored.

TABLE 6-2: EPROM MEMORY ACCESS
TIME ORDERING SUFFIX t

AD<15:0>

EPROM Suffix

TYPICAL EXTERNAL PROGRAM MEMORY CONNECTION DIAGRAM

T Use of VO pins is only required for paged memory.
1 This signal is unused for ROM and EPROM devices.

PIC17C4X | Instruction 4 d 4 5B E
Oscillator Cycle PIC17C43 Nox 8 < =
Frequency | Time (Tcy) | PIC17C42 | PIC17C44 2 8 é
8 MHz 500 ns -25 -25 3 g
16 MHz 250 ns -12 -15 §
20 MHz 200 ns -90 -10 2
25 MHz 160 ns N.A. -70

1 This selection is for use with Microchip EPROMSs.
For intertacing to other manufacturers memory,
please refer to the electrical specifications of the
desired PIC17C4X device, as well as the desired
memory device to ensure compatibility.
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6.2 Data Memory Organization

Data memory is partitioned into two areas. The first is
the General Purpose Registers (GPR) area, while the
second is the Special Function Registers (SFR) area.
The SFRs control the operation of the device.

Portions of data memory are banked, this is for both . i
areas. The GPR area is banked to allow greater than FIGURE 6-6:  PIC17C43 AND PIC17C44
232 bytes of general purpose RAM. SFRs are for the REGISTER FILE MAP
registers that control the peripherat functions. Banking
requires the use of control bits for bank selection. Addr | Unbanked [ - l
These control bits are located in the Bank Select Reg- 00h INDFO
ister (BSR). If an access is made to a location outside 01h FSRO
this banked region, the BSR bits are ignored. 02h PCL
Figure 6-5 shows the data memory map organization 03h PCLATH
for the PIC17C42 and Figure 6-6 for the PIC17C43 and
PIC17C44 devices. 0dh | ALUSTA
05h TOSTA
instructions MOVPF and MOVFP provide the means to o06h CPUSTA
move values from the peripheral area (“P") to any loca-
tion in the register file (“F”), and vice-versa. The defini- 07h | INTSTA
tion of the “P” range is from Oh to 1Fh, while the “F” 08h INDF1
range is Oh to FFh. The “P” range has 8 more locations 0sh FSR1
than peripheral registers (6 locations for the PIC17C43 0Ah WREG
and PIC17C44 devices)which can be used as General 08h TMROL

Purpose Registers. This can be useful in some applica-

tions where variables need to be copied to other loca- 0Ch | TMROH

tions in the general pumpose RAM (such as saving 0Dh | TBLPTRL

status information during an interrupt). OEh | TBLPTRH

The entire data memory can be accessed either directly OFh BSR

or indirectly through file select registers FSRO and Bank0 |Bank1'| Bank2' | Bank3'

FSR1 (see Section 6.4). Indirect addressing uses the

appropriate control bits of the BSR for accesses into 10h PORTA DDRC TMR1 PW1DCL

the banked areas of data memory. The BSR is 11h DDRB PORTC TMR2 PW2DCL

explained in greater detail in Section 6.8. 12h PORTB DDRD TMR3L PWI1DCH
13h RCSTA PORTD TMR3H PW2DCH
14h RCREG DDRE PR1 CA2L

6.2.1  GENERAL PUURPOSE REGISTER (GPR) 15h | TXSTA | PORTE PR2 CA2H
16h | TXREG PIR | PRSUCAIL | TCON1

All devices have some amount of GPR area. The GPRs 17h SPBRG PIE PR3H/CATH | TCONZ

are 8-bits wide. When the GPR area is greater than 18h PRODL

232, it must be banked to allow access to the additional

memory space. 18h PRODH

Only the PIC17C43 and PIC17C44 devices have 1AR

banked memory in the GPR area. To facilitate switching 1Eh

between these banks, the MOVLR bank instruction has

been added to the instruction set. GPRs are not initial- 20h General General

ized by a POR reset and are unchanged on all other Purpose Purpose

resets. RAM? RAM 2

6.2.2  SPECIAL FUNCTION REGISTERS (SFR) i

The SFRs are used by the CPU and peripheraf func- Nofe 1: SFR file locations 10h - 17h are banked. Al

tions to control the operation of the device (see other SFRs ignore the Bank Select Register

Figure 6-5 and Figure 6-6). These registers are static (BSR) bits.

RAM. 2. General Purpose Registers (GPR) locations

The SFRs can be classified into two sets, those associ- 20h - FFh and 120h - 1FFh are banked. All

ated with the “core” function and those related to the other GPRs ignore the Bank Select Register

peripheral functions. Those registers related to the (BSR,) bits.

“core” are described here, while those related to a
peripheral feature are described in the section for each
peripheral feature.

The peripheral registers are in the banked portion of
memory, while the core registers are in the unbanked
region. To facilitate switching between the peripheral
banks, the MOVLB bank instruction has been provided.
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1 = Disable all interrupts

0 = Enables all un-masked interrupts

TO: WDT Time-Out status bit

bit 3:

1 = After power-up or by a CLRWDT instruction

A Watchdog Timer time-out occurred

PD: Power Down status bit

0=

CPU STATUS REGISTER (CPUSTA)

2.2
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bit 2:

1 = After power-up or by the CLRWDT instruction

0 =By execution of the SLEEP instruction

Unimplemented, reads as '0

bit 1-0:

-201-
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FIGURE 6-9: TOSTA REGISTER (ADDRESS: 05H, UNBANKED)

R = Readable bit

W = Writable bit

U = Unimplemented,
reads as ‘0’

-n = Value at POR reset

O WV xXCc
=£58°
« BecyOw . .
W 9293 bit7:  INTEDG: INT Pin Interrupt Edge Select bit
[ c 8 )
] 08SE 5 This bit selects the edge upon which the interrupt is detected.
& 48Es58 1 = Rising edge of RAW/INT pin generates interrupt
‘5 2w = K] 0 =Falling edge of RAO/INT pin generates interrupt
5 £EZ8S bite:  TOSE: Timer0 Clock Input Edge Select bit
= é z 2 ;‘ @ This bit selects the edge upon which TMRO will increment.
8 985253 When TOCS = 0 '
g 2 § EE e 1 = Rising edge of RA1/TOCKI pin increments Timer0 and/or generates a TOCKIF interrupt
2 § 4 : é 0 = Falling edge of RA1/TOCKI pin increments TimerO and/or generates a TOCKIF interrupt
= e%2=§g WhenTOCS =1
o < 3 z f}, 0@ Don't care
- =
gh §Z=23 bits:  TOCS: Timer0 Clock Source Select bit
22 £zt This bit selects the clock source for TMRO.
28a°FT 1 = Internal instruction clock cycle (Tcy)
- ggEgd; 0 =TOCKI pin
¥ 232ES3 bit4-1: PS3:PS0: TimerO Prescale Selection bits
P E8xzB88iL These bits select the prescale value for TMRO.
PS3:PS0 Prescale Value
0000 1:1
0001 1:2
0010 1:4
0011 1:8
0100 1:16
0101 1:32
0110 1:64
0111 1:128
1xxx 1:256

bit 0: Unimpiemented: reads as '0’

6.3 Stack Operation

The PIC17C4X devices have a 16 x 16-bit wide hard-
ware stack (see Figure 6-1). The stack is not part of
either the program or data memory space, and the
stack pointer is neither readable nor writable. The PC is
“PUSHed" onto the stack when a CALL instruction is
executed or an interrupt is acknowledged. The stack is
*POPed" in the event of a RETURN, RETLW, or a RET-
FIE instruction execution. PCLATH is not affected bya
“PUSH” or a “POP” operation.

The stack operates as a circular buffer, with the stack
pointer initialized to ‘0 after all resets. There is a stack
available bit (STKAV) to allow software to ensure that
the stack has not overfiowed. The STKAV bit is set after
a device reset. When the stack pointer equals Fh,
STKAV is cleared. When the stack pointer rolls over
from Fh to Oh, the STKAV bit will be held clear until a
device reset.

After the device is “PUSHed" sixteen times (without a
“POP"), the seventeenth push overwrites the value

from the first push. The eighteenth i
. push overwrites
second push (and so on). e
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6.4 Indirect Addressing

Indirect addressing is a mode of addressing data
memory where the data memory address in the
instruction is not fixed. That is, the register that is to be
read or written can be modified by the program. This
can be useful for data tables in the data memory.
Figure 6-10 shows the operation of indirect address-
ing. This shows the moving of the value to the data
memory address specified by the value of the FSR
_ register.

Example 6-1 shows the use of indirect addressing to
clear RAM in a minimum number of instructions. A sim-
ilar concept could be used to move a defined number
of bytes (block) of data to the SCI transmit register
(TXREG). The starting address of the block of data to
be transmitted could easily be modified by the pro-

gram.
FIGURE 6-10: INDIRECT ADDRESSING

RAM
Instruction
Executed
I Opcode I Address I
File = INDFx
Instruction
Fetched
Opcode Fie | [__FsR_ |

6.4.1  INDIRECT ADDRESSING REGISTERS

The PIC17C4X has four registers for indirect address-
ing. These registers are:

« INDF0O and FSRO
* INDFt and FSR1

Registers INDFO and INDF1 are not physically imple-
mented. Reading or writing to these registers activates
indirect addressing, with the value in the correspond-
ing FSR register being the address of the data. The
FSR is an 8-bit register and allows addressing any-
where in the 256-byte data memory address range.
For banked memory, the bank of memory accessed is
specified by the value in the BSR.

it file INDFO (or INDF1) itself is read indirectly via an
FSR, all '0's are read (Zero bit is set). Similarly, if
INDFO (or INDF1) is written to indirectly, the operation
will be equivalent to a NOP, and the status bits are not
affected.

6.4.2  INDIRECT ADDRESSING OPERATION

The indirect addressing capability has been enhanced
over that of the PIC16CXX family. There are two con-
trol bits associated with each FSR register. These two
bits configure the FSR register to:

Auto-decrement the value (address) in the FSR
after an indirect access

Auto-increment the value (address) in the FSR
after an indirect access

No change to the value (address) in the FSR after
an indirect access

These control bits are located in the ALUSTA register.
The FSR1 register is controlled by the FS3:FS2 bits
and FSRO is controlled by the FS1:FS0 bits.

When using the auto-increment or auto-decrement
features, the effect on the FSR is not reflected in the
ALUSTA register. For example, if the indirect address
causes the FSR to equal '0", the Z bit will not be set.

If the FSR register contains a value of Oh, an indirect
read will read Oh (Zero bit is set) while an indirect write
will be equivalent to a NOP (status bits are not
affected).

Indirect addressing allows single cycle data transfers
within the entire data space. This is possible with the
use of the MOVPF and MOVFP instructions, where either
'p’ or 'f' is specified as INDFO (or INDF1).

If the source or destination of the indirect address is in
banked memory, the location accessed will be deter-
mined by the value in the BSR.

A simple program to clear RAM from 20h - FFh is
shown in Example 6-1.

EXAMPLE 6-1: INDIRECT ADDRESSING
MOVLW 0x20 i

MOVWF FSRO ; FSRO = 20h
BCF ALUSTA, FS1 ; Increment FSR
BSF ALUSTA, FSO ; after access
BCF ALUSTA, C ; € =0
MOVLW END_RAM + 1

LP CLRF INDFO ; Addr(FSR)} = 0
CPFSEQ FSRO ; FSRO = END_RAM+1?

NO, clear next

GOTO LP

YES, All RAM is
cleared

6.5 Table Pointer (TBLPTRL a
IBLPTRH

File registers TBLPTRL and TBLPTRH form a 16-bit
pointer to address the 64K program memory space.
The table pointer is used by instructions TABLWT and
TABLRD.

The TABLRD and the TABLWT instructions allow trans-
fer of data between program and data space. The table
pointer serves as the 16-bit address of the data word
within the program memory. For a more compiete
description of these registers and the operation of Table
Reads and Table Writes, see Section 7.0.

6.6 Table Latch \TH, TBLATL

The table latch (TBLAT) is a 16-bit register, with
TBLATH and TBLATL referring to the high and low
bytes of the register. It is not mapped into data or pro-
gram memory. The table iatch is used as a temporary
holding fatch during data transfer between program and
data memory (see descriptions of instructions TABLRD,
TABLWT, TLRD and TLWT). For a more complete
description of these registers and the operation of Table
Reads and Table Writes, see Section 7.0.
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6.7  Program tounter moauig

unter (PC) is a 16-bit register. PCL, the

w&g ;fagec:’)c, is H(iapped in tl:le data memory. 'PCL

is readable and writable just as is any pther reglster.

PCH is the high byte of the PC and is not directly

addressable. Since PCH is not mapped in da!a or pro-

gram memory, an 8-bit register PCL/_\TH (PC high fatch)

is used as a holding latch for the high byte of the PC.

PCLATH is mapped into data memory. The user can
- read or write PCH through PCLATH.

The 16-bit wide PC is incremented after each instruc-

tion fetch during Q1 unless:

« Modified by GOTO, CALL, LCALL, RETURN, RETLW,

or RETFLE instruction
«» Modified by an interrupt response
» Due to destination write to PCL by an instruction

*Skips™ are equivalent to a forced NOP cycle at the
skipped address.

The operations of the PC and PCLATH for different
instructions are as follows:
a) LCALL instruction:
An 8-bit destination address is provided in the
instruction (opcode). PCLATH is unchanged.
PCLATH — PCH
Opcode<7:0> — PCL
b)  cALL. GoTOo instryctions:
A 13-bit destination address is provided in the
instruction (opcode).
Opcode<12:0> — PC <12:0>
PC<15:13> - PCLATH<7:5>
Opcode<12:8> — PCLATH <4:0>
o B . . PCL:
Any instruction that reads PCL.
PCL — data bus — ALU or destination
PCH — PCLATH
d)  Write instructions on PCL:
Any instruction that writes to PCL.
8-bit data — data bus — PCL
PCLATH — PCH
e Modifu Wi
Any instruction that does a read-write-modify
operation on PCL, such as ADDWF pPCL .
Read: PCL — data bus — ALU
Write:  8-bit result — data bus — PCL
PCLATH — PCH

PCH — PCLATH

The read-modify-write only affects the PCL with the
result. PCH is loaded with the vaiue in the PCLATH. For
example, ADDWF PCL will result in a jump within the
current page. If PC = 03F0h, WREG = 30h and
PCLATH = 03h before instruction, PC = 0320h after the
instruction. To accomplish a true 16-bit computed jump,
the user needs to compute the 16-bit destination
address, write the high byte to PCLATH and then write
the low value to PCL.

The following PC related operations do not change
PCLATH:

a) LCALL, RETLW, and RETFIE instructions.

b) Interrupt vector is forced onto the PC.

¢) Read-modify-write instructions on PCL (e.g.BSF
PCL).

6.8 Bank Select Register (BSR)

The BSR is used to switch between banks in the data
memory area (see Figure 6-11). In the PIC17C42, only
the lower nibble is implemented. While in the
PIC17C43 and PIC17C44 devices, the entire byte is
implemented. The lower nibble is used to select the
peripheral register bank. The upper nibble is used to
select the general purpose memory bank.

All the Special Function Registers (SFRs) are mapped
into the data memory space. In order to accommodate
the large number of registers, a banking scheme has
been used. A segment of the SFRs, from address 10h
to address 17h, is banked. The lower nibble of the bank
select register (BSR) selects the currently active
“peripheral bank”. Effort has been made to group the
peripheral registers of related functionality in one bank.

However, it will still be necessary to switch from bank to
bank in order to address att peripherals related to a sin-

gle task. To assist this, a MOVLB bank instruction is in

the instruction set.

For the PIC17C43 and PIC17C44 devices, the need for
alarge general purpose memory space dictated a gen-
eral purpose RAM banking scheme. The upper nibble
of the BSR selects the currently active general purpose
RAM bank. To assist this, a MOVLR bank instruction
has been provided in the instruction set.

If the currently selected bank is not imptemented (such
as Bank 13), any read will read all '0's..Any write is com-
pleted to the bit bucket and the ALU status bits will be
set/cleared as appropriate.

- Note:

Registers in Bank.15.in:the Special Func-
ion: Register  area, are. reserved for
lcrd:hip‘ use: Reading of registers in this
bank may cause random values to be read.

BSR OPERATION (PIC17C43/44)

FIGURE 6-11:
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70 TABLE READS AND TABLE
WRITES

The PIC17C4X has four instructions that allow the pro-
cessor to move data from the data memory space to
the program memory space, and vice versa. Since the
program memory space is 18-bits wide and the data
memory space is 8-bits wide, two operations are
required to move 16-bit values to/from the data mem-
ory.

The TLWT £, £ and TABLWT t, i, £ instructions are
used to write data from the data memory space to the
program memory space. The TLRD t, £ and TABLRD
z, i, £ instructions are used to write data from the pro-
gram memory space to the data memory space.

The program memory can be internal or external. For
the program memory access to be external, the device
needs to be operating in extended microcontroller or
microprocessor mode.

8.0 HARDWARE MULTIPLIER

The PIC17C43 and PIC17C44 devices have an 8 x 8
nardware multiplier included in the ALU of the device.
By making the multiply a hardware operationy, it com-
pletes in a single instruction cycle. This is an unsigned
multiply that gives a 16-bit result. The result is stored
into the 16-bit PRODuct register (PRODH:PRODL).
The multiplier does not affect any flags in the ALUSTA
register.

Making the 8 x 8 multiplier execute in a single cycle
gives the following advantages:

« Higher computationai throughput

» Reduces code size requirements for muitiply algo-
rithms

The performance increase allows the PIC17C43 and

PIC17C44 devices to be used in applications previ-

ously reserved for Digital Signal Processors.

9.0 WO PORTS

The pIC17C4X devices have five /O ports, PORTA
mrough pORTE. PORTB through PORTE have a cor-
.psponding Data Direction Register (DDR), which is
used to configure the port pins as inputs or outputs.
These five ports are made up of 33 I/O pins. Some of
\nese ports pins are multiplexed with alternate func-

toNs.

pORTC, PORTD and PORTE are muitipiexed with the
system bus. These pins are configured as the system
pus when the device's fuses are selected to Micropro-
cessor of Extended Microcontrolier modes. In the two
other microcontroller modes, these pins are general

purpose 1/O.
PORTA and PORTB are muitiplexed with the peripheral
teatures of the device. These peripheral features are:

« Timer modules

« Capture module

. PWM module

. SCI module (USART)

. External Interrupt pin

When some of these peripherai modules are turned on,
the port pin will automatically configure to the alternate
tunction. The modules that do this are:

« PWM module
+ SCI module
When a pin is automatically configured as an output by
a peripheral module, its data direction bit may be left in
an unknown state. After disabling the peripheral mod-
ule, the user should re-initialize the DDR bit to the
desired configuration.
The other peripheral modules (which require an input)
must have their data direction bit configured appropri-
ately.
Note:  Apinthatis a peripheral input, can be con-
figured as an output(DDRx<y> is cleared).
The: peripheral: events will be determined
by the action output on the port pin.

9.1 PORTA Register

PORTA is a 6-bit wide latch. PORTA does not have a
corresponding Data Direction Register (DDR).
Reading PORTA reads the status of the pins.

The RA1 pin is muitiplexed with TMRO clock input, and
RA4 and RA5 are multiplexed with the SCI functions.
The control of RA4 and RAS as outputs is automatically
configured by the SCI module.

9.1.1 USING RA2, RA3 AS QUTPUTS

The RA2 and RA3 pins are open collector outputs. To
use the RA2 or the RA3 pin(s) as output(s), simply write
1o the PORTA register the desired value. A'0’ will cause
the pin to drive low, while a 1" will cause the pin to float
(hi-impedance). An external pull-up resistor should be
used to pull the pin high. Writes to PORTA will not affect

the other pins.

Note: When using the RA2 or RA3 pin(s) as out-

. put(s), read-modify-write instructions:(such

as BCF, BSF, BTG) on:PORTA are.not rec-
ommended:

‘Such operations read the port pins;.do the

desired operation; and then write this value

to the data:latch. This may. inadvertently

cause theRA2 or'RA3 pins to switch from

input to output (of vice-versa).
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2 PORTB and DDRB Registers

ORTB is an 8-bit wide bi-directional port. The corre-
sonding data direction register is DDRB. A'1' in DORB
snfigures the corresponding port pin as an input. A ‘0’
\ne DDRB register configures the corresponding port
n as an output. Reading PORTB reads the status of
e pins, whereas writing to it will write to the port latch.

sch of the PORTB pins has a weak internal pull-up. A
1gle control bit can turn on all the pull-ups. This is
ine by clearing the RBPU (PORTA<7>) bit. The weak

9.3 PORTC and DDRC Regqisters

PORTC is an 8-bit bi-directional port. The correspond-
ing data direction register is DDRC. A'1' in DDRC con-
figures the corresponding port pin as an input. A '0° in
the DDRC register configures the corresponding port
pin as an output. Reading PORTC reads the status of
the pins, whereas writing to it will write to the port latch.
PORTC is multiplexed with the system bus. When
operating as the system bus, PORTC is the low order
byte of the address/data bus (AD<7:0>). The timing for

the system bus is shown in the Electrical Characteris-

il-up is automatically turned off when the port pin is
tics section.

nfigured as an output. The pull-ups are enabled on
y reset. Note:

This port is configured as the system- bus

)RTB also has an interrupt on change feature. Only - .when'the device’s .configuration  bits' are = H
s configured as inputs can cause this interrupt to selected: to Microprocessor: or Extended o A S
zur (i.e. any RB<7:0> pin configured as an output is Microcontroller. modes.. In the two other 2o 3 ‘é 2
sluded from the interrupt on change comparison). ' microcontroller modes, this port is a gen- w 2 53 % Eont
e input pins (of RB<7:0>) are compared with the eral purpose /O. - = : o583 8 ,8%
ue in the PORTB data latch. The “mismatch” outputs §-52% 25%%8.
RB<7:0> are OR’ed together to generate the RBIF . . - @ %yl w3 g é w "
srrupt (flag latched in PIR<7>). Example 9-2 shows the |nstructaon_ sequence to initial- GE8 .38 % 24 e Aoa
ize PORTC. The Bank Select Register (BSR) must be Z 353878480
selected to Bank 1 for the port to be initialized. E 83 % 23 E § “ é é §
Jis interrupt can wake the device from SLEEP. The L3 5" e g
e, in the interrupt service routine, can clear the inter- EXAMPLE 9-2:  INITIALIZING PORTC E - - - -
ot in one of two ways: MOVLB 1 Select Bank 1 =
X . i CLRF  PORTC Initialize PORTC data
Disable the interrupt by clearing the RBIE latches before setting
(PIE<7>) bit. H the data direction 3
Read-Write PORTB (MOVPF PORTB, PORTE). register g

This will end mismatch condition. Then, clear the
RBIF bit.
mismatch condition will continue to set the RBIF bit.
zading then writing PORTB will end the mismatch
ndition, and allow the RBIF bit to be cleared. i

ais interrupt on mismatch feature, together with soft-
are configurable pull-ups on this port, allows easy

MOVLW OxCF Value used to initialize
data direction
Set RC<3:0> as inputs

RC<S5:4> as outputs

EXAMPLE 9-4:

MOVLB
CLRF

w
4
a
a
]
s
o]
=

MOVLW 0x03

MOVWF DDRC

RC<7:6> as inputs

terface to a key pad and make it possible for wake-up 9.4 PORTD and DDRD Registers %
key- ion. (See ANS52 in the Embedded Con- . v . 2
;I Zg:;é’;’s(’s'on (See ! PORTD is an 8-bit bi-directional port. The correspond- 2 g
‘ . ) ing data direction register is DDRD. A'1" in DDRD con- 8T

1e interrupt on change feature is reqommended for figures the corresponding port pin as an input. A '0' in § g
ake-up on operations where PORTB is only used for the DDRC register configures the corresponding port e

e interrupt on change feature and key depression

pin as an output. Reading PORTD reads the status of
seration.

the pins, whereas writing to it will write to the port latch.
PORTD is multiplexed with the system bus. When
operating as the system bus, PORTD is the high order
byte of the address/data bus (AD<15:8>). The timing
for the system bus is shown in the Electrical Character-
istics section.

\mple 9-1 shows the instruction sequence to initial-
PORTB. The Bank Select Register (BSR) must be
«cted to Bank O for the port to be initialized.

Note: " . This port is configured as the system bus
when“the device’s: configuration bits are
selected to. Microprocessor- or Extended

{AMPLE 9-1: INITIALIZING PORTB

_This port-is configured as the system bus
- when the device’s configuration bits are
‘selected: to Microprocessor:or Extended
- Microcontrolier modes. ‘In the. two other
microconirofler modes, this port'is a gen-
eral purpose I/O.

selected to Bank 1 for the port to be initialized.

Example 9-4 shows the instruction seq
ize PORTE. The Bank Select Register

JLB 0 ; i
; Select Bank 0 .:Microcontroller. modes. In. the: two- other .
IF  PORTB ‘Initialize PORTB by clearing microcontrofler modes, this port is a gen- -]
; output data latches eral purpose O. g
/LW OxCF ;Value used to initialize
;data direction
TWF DDRB ;Set RB<3:0> as inputs Example 9-3 shows the instruction sequence to initial-
RB<S:4> as outputs lzeI PORTD. The Bank Select Register (BSR) must be N ”
DO B s W2 iy D 2
RE<7:6> as inputs selected to Bank 1 for the port to be initialized. E2c 3L c2.25 I‘é P
BT =& aroe s =1
£6s8502Gg423
EXAMPLE 9-3: INITIALIZING PORTD a,e552@ SE_GE .
MOVLE 1 ; Select Bank 1 gz < EB‘S 228 E-lg 25
CLRF-  PORTD Initialize PORTD data c 308 ig 35 2 % 23 a %5
latches before setting E 2 £ E 5 ‘2 to: 2 8 2 - g 2 ﬁ
the data direction w0 Fr-§ge e= o wase
register 8 S“%g:g g;gs(_e;’é
MOVLW O0xCF Value used to initialize o %g % 8 § 2 2 '% w0 % g E S
data direction &y gocgagggvgozg
MOVWF DDRD Set RD<3:0> as inputs 8 3 a g2 e $g8qu § g 5
@ =aw<
RD<5:4> as outputs = Ssg’ao; = mﬁ,\'w"ﬁ
; RD<7:6> as inputs Z E‘J‘)ﬁgﬂ"z‘c‘%.ggm‘—“g
< 55S5EP0ER 3258
W o3E88503 88558
o c‘)cmngUDU“ng
) mo:;mgmnmg;ow
= 82 x 0 =&
f 003030 E0<go=
=D D5 vQald = € >k
wEL-3883388s%
E3fw=0=2%3S s T c
- T xi3is2ac ~ @ 3
< o%@cgé’ﬁmw%%eﬁ
s A0 3Qc3LEECE2ad
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OVERVIEW UF 11MEN
RESOURCES

g PIC17CAX haS four timer modules. Each module
;n generate an interrupt to indicate that an event has
_curred. These timers are called:

TMRO - Timer0 (16-bit timer with programmable
8-bit prescaler)

TMR1 - Timer1 (8-bit timer)

TMR2 - Timer2 (8-bit timer)

TMR3 - Timer3 (16-bit timer)

or enhanced time-base functionality, two input Cap-

res and two Pulse Width Modulation (PWM) outputs

6 possible. The PWMs use the TMR1 and TMR2

sources and the input Captures use the TMR3

1source.

0.1 IMRO Overview

10 TMRO module is a simple 16-bit overtlow counter.
he clock source can ba either the intemal system
ock (Fosc/4) or an extemal clock.

26 TMRO module also has a programmable prescaler
stion. The PS3:PS0 bits (TOSTA<4:1>) determine the
-sscaler value. TMRO can increment at the following
tes: 1:1, 1:2, 1:4, 1:8, 1:16, 1:32, 1:64, 1:128, 1:256.
then TMROQ's clock source is an extemal clock, the
MRO module can be selected to increment on either
@ rising or falling edge.

ynchronization of the extemal clock occurs after the
rascaler. When the prescaler is used, the extemal
ock frequency may be higher then the device's fre-
sency. The maximum frequency is 50 MHz, given the
igh and low time requirements of the clock.

0.0

bit
Unimplemented,

Read as ‘0’
Value at POR resel

Readable bit

R
u
-n

-0

= 1
bit0

RW-0 U

RW-0
[ Pps2 | pPs1 | Pso |
Timer0 and/or generates a TOCKIF interrupt

increments TimerQ and/or generates a TOCKIF interrupt

RW-0

murely

—— il

1:64
1:128
1:256

Prescale Value

02 T vervi

TOSTA REGISTER (ADDRESS: 05H, UNBANKED)

he TMR1 module is an 8-bit timer/counter with an 8-
t period register (PR1). When the TMR1 value rolls
ver from the period match value to Oh, the TMR1 IF
ag is set, and an interrupt will be generated when
nabled. in counter mode, the clock comes from the
B4/TCLK12 pin, which can also be selected to be the
ock for the TMR2 moduie.

MR1 can be concatenated to TMR2 to form a 16-bit
ner. The TMR1 register is the LSB and TMR2 is the
1SB. When in the 16-bit timer mode, there is a corre-
sonding 16-bit period register (PR2:PR1). When the
MR2:TMR1 value rolls over from the period match
alue to Oh, the TMR1IF flag is set, and an interrupt
ill be generated when enabled.

Falling edge of RAO/INT pin generates interrupt

TOSE: Timer0 Clock Input Edge Select bit
Falling edge of RA1/TOCKI pin increments

Rising edge of RA1/TOCKI pi

0000
0001
0010
0011
0100
0101
0110
0111
1xxXX

TOCKI pin
PS3:PS0: Timer0 Prescale Selection bits

RW-0 RW-0 RW-0

INTEDG] TOSE | Tocs | Ps3
PS3:PSO

This bit selects the edge upon which the interrupt is detected

1 = Rising edge of RAO/INT pin generates interrupt
This bit selects the edge upon which TMRO will increment

These bits select the prescale value for TMRO.

INTEDG: INT Pin Interrupt Edge Select bit
This bit selects the clock source for TMRO.

TOCS: Timer0 Clock Source Select bit
1 = Internal instruction clock cycle (Tcy)

Unimplemented: read as '0'

Don’t care

0
1
0
o

bit 0:

FIGURE 11-1:
bit7
bit 7:
bit 6:
bit 5
bit 4-1

phase clocks.

internal

10.3 TMR2 Qverview

The TMR2 module is an 8-bit timer/counter with an 8-
bit period register (PR2). When the TMR2 value rolls
over from the period match value to Oh, the TMR2IF
flag is set, and an interrupt will be generated when
enabled. In counter mode, the clock comes from the
RB4/TCLK12 pin, which can aiso be selected to be the
clock for the TMR1 module.

TMR1 can be concatenated to TMR2 to form a 16-bit
timer. The TMR2 register is the MSB and TMR1 is the
LSB. When in the 16-bit timer mode, there is a corre-
sponding 16-bit period register (PR2:PR1). When the
TMR2:TMR1 vaiue rolls over from the period match
value to Oh, the TMR1IF flag is set, and an interrupt
will be generated when enabled.

104 TMR3 Overview

The TMR3 module is a 16-bit timer/counter with a 16-
bit ‘period register. When the TMR3H:TMR3L value
rolls over to Oh, the TMR3IF bit is set and an interrupt
will be generated when enabled. In counter mode, the
clock comes from the RBS/TCLKS pin.

When operating in the dual capture mode, the period
registers become the second 16-bit capture register.

10.5 le of the Tim n

the
DELAY FROM EXTERNAL CLOCK EDGE

Figure 11-3 shows the synchronization of the external
clock. This synchronization is done after the prescaler.
The output of the prescaler (PSOUT) is sampled twice

in every instruction cycle to detect a rising or a falling
are detailed in the electrical specification section for the

desired device.

intemal clocks, there is a small delay from the time the
external clock edge occurs to the time TMRO is actually
incremented. Figure 11-3 shows that this delay is

between 3 Tosc and 7 Tosc. Thus, for example, mea-
suring the interval between two edges (e.g. period) will

Since the prescaler output is synchronized with the
be accurate within 4 Tosc ( £160 ns @ 25 MHz).

When the extemal clock input is used for TMRO, it is
edge. The timing requirements for the external clock

synchronized with

.21

11.0 TIMERO
The Timer0 (TMRO) module consists of a 16-bit

timer/counter, TMRO. The high byte is TMROH and the
Jow byte is TMROL. A software programmable 8-bit
p,escaler makes an effective 24-bit overflow timer. The
clock source is also software programmable as either
the internal instruction clock or the RA1/TOCK! pin. The

control bits for this module are in register TOSTA

(Figure 11-1).

The timer modules are general purpose, but have ded-
icated resources associated with them. TMR1 and
TMR2 are the time-bases for the two Pulse Width
Modulation (PWM) outputs, while TMR3 is the time-
base for the two input captures.

T
edge can be configured in software. When TOSE is set,

the timer will increment on the rising edge of the

RA1/TOCKI pin. When TOSE is clear, the timer will
increment on the faliing edge of the RA1/TOCKI pin.

The prescaler can be programmed to introduce a pres-
cale of 1:1 to 1:256. The timer increments from 0000h

When TOCS is set, TMRO increments on the internal
clock. When TOCS is clear, TMRO increments on the
external clock (RA1/TOCKI pin). The extemal clock
to FFFFh and rolls over to 0000h. On overflow, the
TMRO Interrupt Flag bit (TOIF) is set. The TMRO inter-
rupt can be masked off by clearing the corresponding
TMRO interrupt Enable bit (TOIE). The TMRO Interrupt
Flag bit (TOIF) is automatically cleared when vectoring
to the TMRO interrupt vector.

1141
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12.1.1.1  EXTERNAL CLOCK INPUT FOR TMR1
OR TMR2

121 Timer1 and Timer2

TIMER1, TIMER2 IN 8-BIT MODE

When TMRxCS is set, the clock source is the
RB4/TCLK12 pin, and the timer will increment on every
falling edge on the RB4/TCLK12 pin. The TCLK12 input
is synchronized with intemal phase clocks. This causes
adelay from the time a falling edge appears on TCLK12
to the time TMR1 or TMR2 is actually incremented. For
the external clock input timing requirements, see the
Electrical Specification section.

12.1.1
goth Timer1 and Timer2 will operate in 8-bit mode
when the T16 bit is clear. These two timers can be inde-
pendently configured to increment from the internal
astruction cycle clock or from an external clock source
on the RB4/TCLK12 pin. The timer clock source is con-
figured by the TMRxCS bit {x = 1 for Timer1 or = 2 for
Timer2). When TMRXCS is clear, the clock source is
ntemal and increments once every instruction cycle
(0SC/4). When TMRXCS is set, the clock source s the 12121 EXTERNAL CLOCK INPUT FOR
AB4/TCLK12 pin, and the timer will increment on every o liiyaivh

talling edge of the RB4/TCLK12 pin.
When TMR1CS is set, the 16-bit TMR2:TMR1 incre-

The timer increments from 00h until it equals the h .
period register (PRx). It then resets to 00h at the next ments on the falling edge of clock input TCLK12. The
input on the RB4/TCLK12 pin is sampled and synchro-

increment cycle. The timer interrupt flag is set when the
temer is reset. Timer1 and Timer2 have individual inter-
rupt flag bits. The Timer1 interrupt flag bit is latched into
TMR1IF, and the Timer2 interrupt flag bit is latched into

TMR2IF.

Each timer also has a corresponding interrupt enable
bit (TMRXIE). The timer interrupt can be enabled by set-
ting this bit and disabled by clearing this bit. For periph-
eral interrupts 1o be enabled, the Peripheral Interrupt
Enable bit must be enabled (PEIE is set) and global
interrupts must be enabled (GLINTD is cleared).

The timers can be tumed on and off under software
control. When the Timerx on control bit (TMRXON) is
set, the timer increments from the clock source. When
TMRXON is cleared, the timer is tumed off and cannot
cause the timer interrupt flag to be set.

nized by the intemal phase clocks twice every instruc-
tion cycle. This causes a delay from the time a falling
edge appears on RB4/TCLK1Z to the time
TMR2:TMR1 is actually incremented. For the external
clock input timing requirements, see the Electrical
Specification section.

TABLE 12-1: TURNING ON 16-BIT TIMER

TMR2ON | TMR1ON Resuit
1 1 16-bit timer
(TMR2:TMR1) ON
0 1 Only TMR1 increments
x 0 16-bit timer OFF
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12.1.2 TIMER1 & TIMER2 IN 16-BIT MODE

i in this
i bit must be set.
16-bit mode, the T16 i
:;?Ozzb%m i TMRZR:;E ﬁgcitgn-t:egn::r incre-
e “"::i: gNr‘r?az(ches the 16-bit penodmree%l::::
?&?‘::P;ﬂ On the following timeFrbc;th;ks,e :
value' is reset to Oh, and the TMR1}

the16-bit timer, the
ing the clock source for > o
Wher: (s:esle%t:? gcontrols the entire 16-bit _ti:::; i at:e
mgzcs is a "don’t care®. Men TM_RICS IIZ (08(::14).
imer increments once every lnstruct. ion cy:ts v
:I"Vnh‘;n TMR1CS is set, the time: éncn.-:m:or on Sven
LK12 pin. t

edge of the RB4/TCl AaoN bits

:xar::i:? to ingreemem, both TMR1ON and TM

must be set (see Table 12-1).

LATION
PULSE WIDTH MODU
1213 (‘ﬂ:f, OUTPUTS WITH TMR1 AND TMR2

idth modulation (PWM) outputs
Two mgh-speeg's:'s:xl\'ﬁhoutput uses Timer1 as its
'mmpm,,aselde:r'rile PWM2 may be software configured to
aher Timer1 or Timer 2 as the time-base. The
m 'g:;etpruts are on the RB2/PWM1 and RB3/PWM2
pos. M output has a maximum resoiution of
B Pwm—bit resolution, the PWM output frequency
10bis A @ 25 MHz clock) and at 8-bit resolution the
5244 kqu(t frequency is 97.7 kHz. The duty cycle of
mm?can vary from 0% to 100%.

12-5 shows a simplified biock qiagram of the
A odule. The duty cycle register is double buff-
PWMt rrn litch 'free operation. Figure 12-6 shows how a
e‘(::;’ ?:o?nd occur if the duty cycle registers were not
gouble buffered. '

The user needs to set the PWM1ON bit (T CON2<4>) t.o

le the PWM1 output. When the PWM1ON bit is
enabne RB2/PWM1 pin is configured as PWM1 oqtput
o ; rced as an output irrespective of the Qat.a direc-
and bqt (DDRB<2>). When the PWM1ON bit is clear,
o irl1 behaves as a port pin and its direction is con-
:::jl:d by its data direction bit (DDRB<2>). Similarly, the
PWM20ON (TCON2<55) bit controls the configuration of

the RB3/PWM2 pin.

FIGURE 12-5: SIMPLIFIED PWM BLOCK
DIAGRAM

Duty Cycle registers Y FTWXDCL<7:6>

PWXDCH T ¢ Wiite

TR
X pin
Latch [fC.

o

[ (Siave) - RCy/PWMx
Comparator Q
L TMR2 _ [(Note m S PWMxON

: 8-bit timer is concatenated with 2-bit internal Q clock|
Note 1 g;bz bits of the prescaler to create 10-bit time-base.
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122 Timer3

TMR3 is a 16-bit timer consisting of the TMR3H and
TMR3L registers. TMR3H is the high byte of the timer
and TMR3L is the jow byte. This timer has an associ-
ated 16-bit period register (PHSH/CA1H:PR3L/CAIL).
This period register can be software configured to bea
second 16-bit capture register,

When the TMR3CS bit (TCON1 <2>)is clear, the timer
increments every instruction cycle (OSC/4). When
TMR3CS is set, the timer increments on every falling
edge of the RBS/T CLK3 pin. In either mode, the
TMR3ON bit must be set for the timer to increment,
When TMR3ON is clear, the timer wilf not increment or
set the TMR3IF bit.

TMR3 has two modes of operation, depending on the
CA1/PR3 bit (TCON2<3>). These modes are:

* One capture ang one period register mode
* Dual capture register mode

The PIC17C4X has up to-two 16-bit Capture registers
that capture the 16-bit value of TMR3 when events are

* arising edge

* afalling edge

* 4 rising edges

* 16 rising edges

Each 16-bit capture register has an interrupt flag asso-
ciated with it. The flag is set when a capture is made.
The capture module is truly part of the Timer3 bilock.
Figure 12-7 ang Figure 12-8 show the block diagrams
for the two modes of operation.

1221 ONE CAPTURE AND ONE PERIOD
REGISTER MQDE

In this mode registers PR3H/CA1H ang PR3L/CA1L
constitute a 16-bit period register. A block diagram s

Capture1 is disabled in thig mode, and the correspond-
ing Interrupt bit ca1ip is never set. mer3 increments
until it equals the value in the period register ang then
resets to 0000h.

occur. The possible events are:

¢ Capture on every falling edge
* Capture on every rising edge
* Capture 8very 4th rising edge
* Capture every 16th rising edge

When a capture takes place, an interrupt flag is latched
upto the CA2IF bit, This interrupt can be enabled by set-

interrupt to be acknowledged. The CA2IF interrupt flag
bit must be cleared in software,

When the capture prescaje selectis changed, the pres-
caler is not reset and an event may pe generated.
Therefore, the first Capture after sych a change wilf be
ambiguous., However, it sets the time-base for the next
capture. The prescaler is reset upon chip reset,
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in RB1/CAP2 is a multiplexed pin. When
Esgéu:: ap port pin, Capture2 is not disableq. However,
the user can simply disable the Capture2 interrupt py
clearing CA2IE. If RB1/CAP2 is useq.as an output pin,
the user can activate a capture by writing to the port pin.
This may be useful during development phase to emu-
late a capture interrupt. A
The input on capture pin RB1/CAP2 i_s synchrongd
internally to internal phase clocks. This imposes cen_am
restrictions on the input waveform (see-the Electrical
Specification section for timing).
The Capture2 overflow status flag bit is double buf_f-
ered. The master bit is set if one f:aptured word is
already residing in the Capture2 register _and another
“event” has occurred on the RB1/CA2 pin. The new
event will not transfer the Timer3 value to the capture
register, protecting the previous unread capture valug.
When the user reads both the high and the low bytes (in
any order) of the Capture2 register, the ma;ter overflow
bit is transferred to the slave overflow bit (CA20VF)
and then the master bit is reset. The user can then read
TCON2 to determine the value of CA20VF.

The recommended sequence to read cgpture registel;s
and capture overflow flag bits is shown in
Example 12-1.

MPLE 12-1: SEQUENCE TO READ
A CAPTURE REGISTERS
‘MOVLB 3 ; Select Bank 3

MOVPF CA2L, LO_BYTE ; Read Capture2 low
; byte, store in LO_BYTE

MOVPF CAZH, HI_BYTE ; Read Capture2 high
; byte, store in HI_BYTE

MOVPF TCON2, STAT_VAL ; Read TCON2 into file
; STAT_VAL

222 DUAL CAPTURE! REGISTER MODE

mode i d by setting CA1/PR3. A block dia-
ind ?vns‘?:le;:;ureYI 2-8. In this mode, TMR3 runs
m’m : :::anod register and increments from 0000h to
and rolls over to 0000h. The Timer3 interrupt
fFFF(h‘rMFlSlF) is set on this roll over. The TMR3IF bit
;::g be cleared in software.
Registers PR3H/CATH and PR3L/CA1L make a 16-bit
capture register (Capture?). it capture_s events on pin
ABO/CAP1. Capture mode is configured by the
CA1ED? and CATEDO bits. Capture? Interrupt Flag bit
(CA1IF) is set on the capture event. The corresponding
nterrupt mask bitis CA1IE . The Capture1 overflow sta-
tus bit is CATOVF.

The Capture2 overflow status flag bit is double byfi-
ered. The master bit is set if one captured word is
already residing in the Capture2 register and another
“event” has occurred on the RB1/CA2 pin. The new
event will not transfer the Timer3 value to the capture
register which protects the previous unread capture
value. When the user reads both the high and the low
bytes (in any order) of the Capture2 register, the master
overflow bit is transferred to the slave overflow bit
(CA20VF) and then the master bit is reset. The user
can then read TCON2 to determine the value of
CA20VF.

The operation of the Capture1 feature is identical to
Capture2 (as described in Section 12.2.1).

12.2.3 EXTERNAL CLOCK INPUT FOR TIMER3

When TMR3CS is set, the 16-bit TMR3 increments on
the falling edge of clock input TCLK3. The input on the
RBS/TCLK3 pin is sampled and synchronized by the
internal phase clocks twice every instruction cycle. This
causes a delay from the time a falling edge appears on
TCLK3 to the time TMR3 is actually incremented. For
the external clock input timing requirements, see the
Electrical Specification section. Figure 12-9 shows the
timing diagram when operating from an external clock.

12.2.4 READING/WRITING TIMER3

Since Timer3 is a 16-bit timer ang only 8-bits at a time
can be read or written, care shouid be taken when reag.
Ing or writing while the timer is running. The begt

Timer3 (using the TMR3ON bit). However, if it is neces-
sary tq keep Timer3 free-runm'ng, care must be taken,
For writing to the 16-bit Timer3, Example 12-2 may be

used. For reading the 16-bit Timer3, Example 12-3 may
be used.

EXAMPLE 12-2: WRITING TO TMR3

BSF CPUSTA, GLINTD ; Disable interrupt
MOVFP RAM_r, TMR3L H

MOWP RAM_H, TMR3Y ;

BCF CPUSTA, GLINTD ; Done, enable interrupt

EXAMPLE 12-3: READING FROM TMR3
MOVPF TMR3L, TMPLO iread low tmrg
MOVPF TMR3H, TMPHT ;read high tmrg
MOVFpP TMPLO, WREG Jtmplo —» wreg
CPFSLT TMR3L, WREG ;tmrol < wreg?

RETFIE ino then return
MOovPF TMR3L, TMPLO iread low tmrg

MovpF TMR3H, TMPHI iread high tmro
RETFIE ;return

Interrupts must be disabled during this Subroutine,
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SERIAL COMMUNICATION

130 INTERFACE (SCI) MODULE

The Serial Communication Interface (SCI) module is a

i /O module. The SC! (USART) can be configured
sanam" duplex asynchronous system that can commu-
asam with peripheral devices such as CRT terminais
nica ersonal computers, or it can be configured as a
hatf dzplex synchronous system that can CO"}municate
with peripherai devicaes such as A/D or D/A integrated
cireuits, Serial EEPROMSs etc. The SCI can be config-

ured in the following modes:

» Asynchronous (full duplex)

o Synchronous - Master (haif duplex)
. Synchronous - Slave (half duplex)

The SPEN (RCSTA<7>) bit has to be set in order to
configure RC6 and RC7 as the Serial Communication

Interface.

The SCl module will control the direction of the
RA4/RX/DT and RA5/TX/CK pins, depsnding on the
states of the SCI configuration bits in the RCSTA and
TXSTA registers. The bits that control I/O direction are:

* SPEN
* TXEN
* SREN
+ CREN
» CSRC

The Transmit Status And Control Register is shown in
Figure 13-1, while the Receive Status And Control Reg-
ister is shown in Figure 13-2.

FIGURE 13-1: TXSTA REGISTER (ADDRESS: 15H, BANK 0)
—
RW-0_ RW-0 RW-0 RW-0 U-90 U-90 R-1 R/W - x
CSRC | TX8/9 | TXEN [SYNC| — [ — [ TRMT [ TXD8 | |R=Readable bit
bit7 bito | W = Writable bit
-n = Value at POR reset
{x = unknown)
bit7: CSRC: Clock Source Select bit
Synchronous mode:
1 = Master Mode {Clock generated intemally from BRG)
0 = Slave mode (Clock from extemal source)
Asynchronous mode:
Don't care
bit6:  TX8/9: Transmit Data Length bit
1 = Selects 9-bit transmission
0 = Selects 8-bit transmission
bit5:  TXEN: Transmit Enable bit
1 = Transmit enabled
0 = Transmit disabled
SREN/CREN overrides TXEN in SYNC mode
bit 4: SYNC: SCI mode Select bit
(Synchronous/Asynchronous)
1 = Synchronous mode
0 = Asynchronous mode
bit 3-2: Unimplemented, reads as ‘0’
bit1:  TRMT: Transmit Shift Register (TSR) Empty bit
1 =TSR empty
0 =TSR full
bit0:  TXDS: 9th bit of transmit data (can be used to caiculated the parity in software)
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SPECIAL FEATURES OF THE
cPU

What sets a microcontrofier apart from other proces-
sors are special circuits to deal with the needs of real
time applications. The PIC17CXX family has a host of
such features intended to maximize system reliability,
minimize cost through selimination of externai compo-
nents, provide power saving operating modes and offer
code protection. These are:

« OSC selection

Reset

- Power-On Reset (POR)

- Power-Up Timer (PWRT)

- Oscillator Start-Up Timer (OST)

Interrupts

Watchdog Timer (WDT)

SLEEP

Code protection

14.0

-

FIGURE 14-1: CONFIGURATION WORD

The PIC17CXX has a Watchdog Timer which can be
shut off only through EPROM bits. It runs off its own RC
oscillator for added reliability. There are two timers that
offer necessary delays on power-up. One is the Oscil-
lator Start-Up Timer (OST), intendad to keep the chip in
RESET until the crystal oscillator is stable. Tha other is
the Power-Up Timer (PWRT), which provides a fixed
delay of 96 ms (nominal) on power up only, designed to
keep the part in RESET while the power supply stabi-
lizes. With these two timers on-chip, most applications
need no extemal resst circuitry,

The SLEEP mode is designed to offer a very low cur-
rent power-down mode. The user can wake from
SLEEP through external reset, watchdog timer time-out
or through an interrupt. Several oscillator options are
also mads available to allow the part to fit the applica-
tion. The RC oscillator option saves system cost while
the LF crystal option saves power. Configuration bits
are used to select various options. This configuration
word has the format shown in Figure 14-1.

-

U-x U-x U-x U-x U-x U-x U-x RP-1
(= [ = [ =T =T =T — T — Temt]
bit15-7 bit0
U-x RP-0 U-x RP-1 RAP-1 RP- 1_RP-1 RP-1 '
| — 1Pt | — T PMo [wDTPs1|wpDTPSo! FOSC1 | FOSCO | |R = Readable bt

bit15-7

bit 15-9: Unimplemented, reads asa '1'

111 =Microprocessor Mode

110 =Extended microcontroller mode

101 =Microcontroller mode

000 =Code protected microcontrotler mode

11 = EC oscillator
10 = XT oscillator
01 = RC oscillator
00 = LF oscillator

T This bit does not exist on the PIC17C42. Reading

bit 8,6,4: PM2, PM1, PMO, Processor Mode Sefect bi

bit 7, 5: Unimplemented, reads as a '0'
bit 3-2: WDTPS1:WDTPS0, WDT Postscaler Select bits
11 = WDT enabled, postscaler = 1
10 = WDT enabled, postscaler = 256
01 = WDT enabled, postscaler = 64
00 = WDT disabled, 16-bit overflow timer
bit 1-0: FOSC1:FOSCO, Oscillator Select bits

P = Programmable bit

U = Unimplemented

-n = Value for Erased Device
{X = unknown)

bit0

its

this bit will return an unknown value (x).
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14.1 Configuration Bits

The PIC17CXX has seven configuration locations (see
Table 14-1). These locations can be programmed (read
as ‘0') or left unprogrammed (read as 1 '} to select vari-
ous device configurations. Any write to a configuration
location, regardless of the data, will program that con-
figuration bit. A TABLWT instruction is required to write
to program memory locations. The configuration bits
can be read by using the TABLRD instructions. Reading
any configuration location between FEQOh and FEO7h
will read the low byte of the configuration word (see
Figure 14-1) into the TABLATL register. The TABLATH
register will be FFh. Reading a configuration location
between FEO8h and FEOFh will read the high byte of
the configuration word into the TABLATL register. The
TABLATH register will be FFh.

Addresses FEQOh thru FEOFh are only in the program
memory space for microcontroller and code protected
microcontroiler modes. A device programmer will be
able to read the configuration word in any processor
mode. See programming specifications for more detail.

TABLE 14-1: CONFIGURATION

LOCATIONS

Bit Address
FOSCO FEOOh
FOSC1 FEO1h
WDTPS0 FEO2h
WDTPS1 FEO3h
PMO FEO4h
PM1 FEO6h

PM2 + FEO8h t

t This location does not exist on the PIC17C42.

. Note:  Whe ;:ﬁkcgrafnming,ﬁjg;dgsifga‘;configuraw
tion locations, they must be programmed in
s ; 3 ; !

14.2  Oscillator Configurations

1421  OSCILLATOR TYPES

The PIC17CXX can be operated in four different oscil.
lator modes. The user can program two configuration
bits (FOSC1:FOSCO) to select one of these four
modes:

s LF: Low Power Crystal
* XT: Crystal/Resonator
*» EC: Externai Clock input
* RC: Resistor/Capacitor

1422 CRYSTAL OSCILLATOR/ CERAMIC
RESONATORS

In XT or LF modes, a crystal or ceramic resonator is
connected to the OSC1/CLKIN and OSC2/CLKOUT
pins to establish osciliation (Figure 14-2).  The
PIC17CXX Oscillator design requires the use of a par-
allel cut crystal. Use of a series cut crystal may give a

frequency out of the crystal manufacturers specifica-
tions.

For frequencies above 20 MHz, it is common for the
Crystai to be an overtone mode crystal. Use of overtone
mode crystals require a tank circuit to attenuate the
gain at the fundamentaf frequency. Figure 14-3 shows
an example of this.

_SKrlpt zum Hardware-Praktikum

FIGURE 14-2: CRYSTAL OR CERAMIC

RESONATOR OPERATION
(XTOR LF OSC
CONFIGURATION)
. 0sCt
ct
3 XTAL ERF SLEEP
= oscz| “ 1
)_L Notei}e {>c
c2 To intemal
logic
PIC17CXX

See Table 14-2 and Table 14-3 for recommended
values of C1 and C2.

Note 1: A series resistor may be required for AT strip
cut crystals.

. CRYSTAL OPERATION,
FIGURE 1 OVERTONE CRYSTALS (XT
0SC CONFIGURATION)
—

ct 0osCt

1 Wm
; c2 osce {>o.

vw}’___._

Ir-ﬂ

H PIC17C42

‘ 0.1 uF
To filter the fundamental frequency

| - et

l Where f = tank circuit resonant frequency. This should be
midway between the fundamental and the 3rd overtone
frequencies of the crystal.

TABLE 14-2: CAPACITOR SELECTION

FOR CERAMIC
RESONATORS
Oscillator Resonator Capacitor Range
Type Frequency C1=C2
LF 455 kHz 15 - 68 pF
2.0 MHz 10 - 33 pF
XT 4.0 MHz 22 - 68 pF
8.0 MHz 33 -100 pF
16.0 MHz 33 - 100 pF

Higher capacitance increases the stability of the
oscillator but also increases the start-up time. These
values are for design guidance only. Since each res-
onator has its own characteristics, the user shquld
consuit the resonator manufacturer for appropriate
values of exteral components.

Resonators Used:

455 kHz | Panasonic EFO-A455K04B +/-0.3%
2.0 MHz |Murata Erie CSA2.00MG +/-0.5%
4.0 MHz | Murata Erie CSA4.00MG +/-0.5%
8.0 MHz | Murata Erie CSA8.00MT +/-0.5%
16.0 MHz | Murata Efie CSA16.00MX +/-0.5%

Resonators used did not have built-in capacitors.
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FIGURE 14-5: EXTERNAL PARALLEL

TABLE 14-3: gg:ﬁé%r\r(csﬁAiELECTION RESONANT CRYSTAL
OSCILLATOR OSCILLATOR CIRCUIT
| Osc Freq c1 e v To Other
Type 10k Dovices  oc17exx
LF 32kHz' [100-150 pF | 100-150 pF
1 MHz 10-33 pF 10-33 pF
2 MHz 10-33 pF 10-33 pF
XT 2 MHz 47-100 pF 47-100 pF
4 MHz 15-68 pF 15-68 pF L
8MHz? | 15-47pF 15-47 pF XTAL
16 MHz 8D TBD —i0
25 MHz 15-47 pF 15-47 pF 10k
Higher capacitance increasas the stability of the !
20 pF L 20 pF

oscillator but also increases the start-up time and the
oscillator current. These values are for design guid-
ance only. Rs may be required in XT mode to avoid

Figure 14-6 shows a series resonant oscillator circuit.

overdriving the crystals with low drive level specifica-
tion. Since each crystal has its own characteristics,
the user should consult the crystal manufacturer for

This circuit is also designed to use the fundamental fre-
quency of the crystal. The inverter performs a
180-degree phase shift in a series resonant oscillator

appropriate values for extemal components. circuit. The 330 kK2 resistors provide the negative feed-

Note 1: For VoD > 4.5V, C1 = C2~ 30 pf is recom- back to bias the inverters in their linear region.
mended. x
2: Rs of 330Q is required for a capacitor com- FIGURE 14-6: EXTERNAL SERIES §
bination of 15/15 pF. RESONANT CRYSTAL w 5
Crystals Used: OSCILLATOR CIRCUIT g T .
32.768 kHz | Epson C-001R32.768K-A |+ 20 PPM @ 8
10MHz___|ECS ECS-10-132 £50 PPM @ wora ToOter = 3
20MHz___|ECS ECS-20-5-1 + 50 PPM e PICI7CXX < - S
40MHz _|ECS ECS-40-5-4 £50 PPM TaRses | TR g 8l m.g
8OMHz _ |ECS ECS-80-S-4 £ 50 PPM ’- hee oser ] °©
160 MHz__|TBD TBD - S
25MHz | CTS CTS25M +50 PPM JXEIA‘L T 3
1L .. 2
142.3 EXTERNAL CLOCK OSCILLATOR ;.‘ &
In the EC oscillator mode, the OSC1 input can be E g b
driven by CMOS drivers. In this mode, the % > g €
P ‘s 1]
OSC1/CLKIN pin is hi-impedance and the OSC2/CLK- 1425 RC OSCILLATOR g < 3 ¢

QUT pin is the CLKOUT output (4 Tosc).

FIGURE 14-4: EXTERNAL CLOCK INPUT
OPERATION (EC OSC
CONFIGURATION)

Clock from -{>o—— osct
ext. system PIC17CXX

CLKOUT «— 08C2
(Fosc/4)

14.2.4 EXTERNAL CRYSTAL OSCILLATOR
CIRCUIT

Either a prepackaged oscillator can be used ora simple
oscillator circuit with TTL gates can be built. Prepack-
aged oscillators provide a wide operating range and
better stability. A well-designed crystal oscillator will
provide good performance with TTL gates. Two types
of crystal oscillator circuits can be used: one with series
resonance, or one with parallel resonancs.

Figure 14-5 shows implementation of a parallel reso-
nant oscillator circuit. The circuit is designed to uss the
fundamental frequency of the crystal. The 74AS04
inverter performs the 180-degree phase shift that a par-
allel osciliator requires. The 4.7 kQ resistor provides
the negative feedback for stability. The 10 kQ potenti-
ometer biases the 74AS04 in the linear region. This
sould be used for external oscillator designs.

For timing insensitive applications, the RC device
option offers additional cost savings. RC oscillator fre-
quency is a function of the supply voltage, the resistor
(Rext) and capacitor (Cext) values, and the operating
temperature. In addition to this, oscillator frequency will
vary from unit to unit due to normal process parameter
variation, Furthermore, the difference in lead frame
capacitance between package types will also affect
oscillation frequency, especially for low Cext values.
The user also needs to take into account variation due
to tolerance of external R and C components used.
Figure 14-6 shows how the R/C combination is con-
nected to the PIC17CXX. For Rext values below
2.2 kK, the oscillator operation may become unstable,
or stop completely. For very high Rext values (e.g.
1 MQ), the oscillator becomes sensitive to noise,
humidity and leakage. Thus, we recommend to keep
Rext between 3 k€ and 100 kQ.

Although the osciilator will operate with no extemat
capacitor (Cext = 0 pF), we recommend using values
above 20 pF for noise and stability reasons. With little
or no extemal capacitance, oscillation frequency can
vary dramatically due to changes in extemal capaci-
tances, such as PCB trace capacitance or package
lead frame capacitancs.
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See Section 18.0 for RC frequency variation from pan

to part due to normal process variation. The variation
is larger for larger R (since leakage current variation will

affect RC frequency more for large R) and for smaller C
poses or to synchronize other logic (see Figure 3-2 for

(since variation of input capacitance will affect RC fre-
waveform).

quency more).
the OSC2/CLKOUT pin, and can be used for test pur-

due to Voo for given Rext/Cext values as wel
The oscillator frequency, divided by 4, is available on

quency variation due to operating tem|

See Section 18.0 for variation of oscillator fr
R, C, and Vbb values.



14.3  Watchdog Timer (WDT)

The Watchdog Timer's function is to recover from soft-
ware malfunction. The WDT uses an intemal free run-
ning on-chip RC oscillator for its clock source. This
does not require any external components. This RC
oscillator is separate from the RC oscillator of the
OSC1/CLKIN pin. That means that the WDT will run,
aven if the clock on the OSC1/CLKIN and OSC2/CLK-
OUT pins of the device has been stopped, for example,
by execution of a SLEEP instruction. During normal
operation and SLEEP mode, a WDT time-out gener-
ates a device RESET. The WDT can be permanently
disabled by programming the configuration bits
WDTPS1:WDTPS0 as '00' (Section 14.1).

Under normal operation, the WDT must be cleared on
a reguiar interval. This time is less the the minimum
WDT overflow time. Not clearing the WDT in this time-
frame will cause the WDT to overflow and reset the

=0 1
. B~z d
device. 3 é 83 Ez s
1431 WDT PERIOD = 32227

o >3

The WDT has a nominal time-out period of 12 ms, (with ,;_ cg =i
postscaler = 1). The time-out periods vary with temper- o b4 g HIHE
ature, VDD and process variations from part to part (see E 3 i & E :.
DC specs). If longer time-out periods are desired, a 2 = [
postscaler with a division ratio of up to 1:256 can be

assigned to the WDT. Thus, typical time-out periods up
to 3.0 seconds can be realized.

The CLRWDT and SLEEP instructions clear the WDT

5
P 2

5 2 H
and the postscaler (if assigned to the WDT) and pre- ‘(‘n} E 5 =
vent it from timing out thus generating a device RESET 2 » = o
condition. K £ g
The TO bit in the STATUS register will be cleared upon ® a2
a WDT time-out.

Bit

WDTPS1]| WDTPSO|. FOSCY |
MCLR and Watchdog Timer time-out reset.
d, wili read as all '1's

Bit3

d, or if unprog

REGISTERS/BITS ASSOCIATED WITH THE WATCHDOG TIMER
4

E Bl &

< §2

14.32 CLEARING THE WDT AND POSTSCALER g . :% g 3

= 3 giee

The WDT and postscaler are cleared when: g o 3 g 3
¢ The device is in the reset state 8 R §§ g
« A SLEEP instruction is executed u_:| . g . § : K 5
» A CLRWDT instruction is executed = % .g é% % 8
« Wake-up from SLEEP by an interrupt g E “’E-’ % 26 g d E gé
The WDT counter/postscaler will start counting on the = 3E E ‘éfg 2 g ] §
first adge after the device exits the reset state. g g ge ~ j;é R
Q oz = $35 4
14.33 WDT PROGRAMMING CONSIDERATIONS 5 g § [ 3 § ; §
x aL €5 U=
It should aiso be taken in account that under worst case : g% 3 . . % § :% E
conditions (VDD = Min., Temperature = Max., max. b 2= 2% : 122 _gg EE
WDT postscaler) it may take several seconds before a & 5 g % 8 # 2 [8|5]% 5 f;? H
WDT time-out occurs. ' _ :.! 5 §% 33_' - g 522
The WDT and postscaler is the Power-Up timer during w 2g " H | § as

the Power-On Reset sequence. % g % ﬁ § 2 % .

(=% 5

14.3.4 WDT AS NORMAL TIMER g . ﬁ gis2

When the WDT is selected as a normat timer, the clock
source is the device clock. Neither the WDT nor the
postscaler are directly readable or writable. The over-
flow time is 65536 Tosc cycles. On overflow, the Tﬁ‘bﬂ
is cleared (device is not reset). The CLRWDT instruction
can be used to set the TO bit. This allows this timer to
be a simple overflow timer. When in sleep, this timer is
stopped.
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14.4 Power-Down Mode (SLEEP) bit, which is set on power-up, is cleared when SLEEP
is invoked. The TO bit is cleared if WDT time-out

The Power-Down mode is entered by executing a occurred (and caused wake-up).
sLEEP instruction. This clears the Watchdog Timer and
postscaler (if enabled). The PD bit is cleared and the
TO bit is set (in the CPUSTA register). In sieep mode,
the oscillator driver is tumed off. The I/O ports maintain

When the SLEEP instruction is being executed, the next
instruction (PC + 1) is pre-fetched. For the device to
wake-up through an interrupt event, the corresponding
interrupt enable bit must be set (enabled). Wake-up is

their status (driving high, low, o hi-impedance). regardless of the state of the GLINTD bit. If the GLINTD
The MCLF/VPP pin must be at a logic high level bit is set (disabled), the device continues execution at
(ViHMC). A WDT time-out RESET does not drive the the instruction after the SLEEP instruction. If the
MCLR/VPP pin low. GLINTD bit is clear (enabled), the device executes the

instruction after the SLEEP -instruction and then
144.1  WAKE-UP FROM SLEEP branches to the interrupt vector address. In cases

where the execution of the instruction following SLEEP
is not desirable, the user should have a'NOP after the
SLEEP instruction.

_If the: global . interrupts. are: 'disabled;
(GLINTD is set), but any interrupt: source
has both its interrupt enable bit and the cor-

responding \ set, the

The device can wake up from SLEEP through one of
the following events:

« APOR reset

« External reset input on MCLR/VPP pin

« WDT time-out reset (if WDOT was enabled)

« Interrupt from RAO/INT pin, RB port change,
TOCKI interrupt, or some Peripheral Interrupts

“Note:

The following peripheral interrupts can wake-up from
SLEEP: i B
o Capture1 interrupt The WDT is cleared when the device wake from
« Capture2 interrupt SLEEP, regardless of the source of wake-up.

¢ SCI synchronous slave transmit interrupt 14.4.1.1 WAKE-UP DELAY
« SCI synchronous slave receive interrupt

When the oscillator type is configured in XT or LF

Other peripherals can not generate interrupts since mode, the Oscillator Start-Up Timer (OST) is activated
during SLEEP, no on-chip Q clocks are present. on wake-up. The OST will keep the device in reset for
Any reset event will cause a device reset. Any interrupt 1024 Tosc. This needs to be taken into account when
event is considered a continuation of program execu- considering the interrupt response time when coming
tion. The TO and PD bits in the CPUSTA register can out of SLEEP.

be used to determine the cause of device reset. The PD

FIGURE 14-9: WAKE-UP FROM SLEEP THROUGH INTERRUPT

vt az2| a3l Qs Q1] az] 3] Q4. at] Q2| Q3| Q4. Q1| @2l Q3f Q4. a1 @2| Q3| Q4.
osct y : :
. : i i Tos\(g) . . v

CLKOUT(@) A / A / A / \ / L — .

INT : : \ : : : :
(RAO/INT pin) : . ( . . ‘ X
INTF flag - : : /. . " Interrupt Latency (2)
GLINTD bit ! : : : . : :

1 g ‘Processon ! '

IN TION FLOW i ,In SLEEP, : .’ :
PC ¢ PC X PCHT X PTFZ X [8j9}¢7:8] X U00U5h
INSUCHONS . 1nst (PC) = SLEEP | Inst (PC+1) : . mst(PC+d) ‘
Instruction [ - . . . . — T
executed { Inst (PC-1) : SLEEP : ! : Inst (PC+1) ‘ ummy Cycle .

Note 1: XT or LF oscillator mode assumed.
2: Tost = 1024 Tosc (drawing not to scale). This delay will not be there for RC osc mode.
3: When GLINTD = 0 processor jumps to interrupt routine after wake-up. If GLINTD = 1, execution will continue in line.
4: CLKOUT is not available in these osc modes, but shown here for timing reference.

1442 MINIMIZING CURRENT CONSUMPTION 145 Code Protection
To minimize current consumption, ali I/O pins should be The code in the pro
N ) i i gram memory can be protected by
either at VDD, or Vss, with no external circuitry drawing selecting the microcontroller in
current from the IO pin. /O pins that are hi-impedance P code protected mode

¢ . ’ M2, PM1, PMO = '000").
inputs shouid be pulled high or low externally to avoid —

switching currents caused by floating inputs. The Nota:
TOCK! input should be at VoD or Vss. The contributions
from on-chip pull-ups on PORTB should aiso be con-

sidered, and disabled when possible.

gram memory space, can continue to read or write the
program memory. An instruction that is executed out-
side of the internal program memory range wilt be inhib-
ited from writing to or reading from program memory.

-does: not.recommend:code:pro-
indowed devices; Thi
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10.5.2 Befehlssatz des PIC17C4X
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ADDLW

ADD Literal to WREG ADDWFC ADDWREG and Carry bitto f
Syntax: [ fabel] ADDLW K Syntax: [ /label JADDWFC  f,d
Operands: 0<ks<255 Operands: 0<f<255
Operation: (WREG) + k — (WREG) de [0.1]
Status Affected: OV, C, DC, Z Operation: (WREG) + (f) + C — (dest)
Encoding: | 1011 [ o001 | ek | ok | Status Affected: OV, G, DC, Z
Description: The contents of WREG are added to Encoding: m°°1 | oooa | eees | e |
the eight bit literal 'k' and the result is Description: . Add WREG, the Carry Flag and data
placed in WREG. memory location 'f. If 'd'is 0, the resultis
Words: 1 placed !n WREG. If'd'is 1, t.he result is
Cval placed in data memory location ‘f.
ycles: ! Words: 1
: 0x1
Example: ADDLW x15 Cydles: 1
Before Instruction .
WREG = 0x10 Example: ADDWFC REG 0
After Instruction Before Instfuctlon
WREG = O0x4D
After Instruction
Carrybit = 0
REG = 0x02
WREG = 0x50
ADDWF ADDWREG tof ANDLW And Literal with WREG
Syntax: { label] ADDWF fd Syntax: { label} ANDLW K
Operands: 0<f<255 Operands: 0<k<255
de [0.1] Operation: (WREG) .AND. (k) > (WREG)
Operation: (WREG) + (f) — (dest) Status Affected:  Z
Status Affected: OV, G, DC, Z Encoding: [ 1011 | o101 B l Kkkkk l
Encoding: [ o000 | 1124 | eeee l ffffJ Description: The contents of WREG are AND'ed with
Description: Add WREG to register . If 'd"is 0 the the eight bit literal 'k'. The result is
result is stored in WREG. If 'd'is 1 the placed in WREG.
result is stored back in register 'f'. Words: 1
Words: 1 Cycles: 1
Cycles: 1 Example: ANDLW  OX5F
Example: ADDWF  REG, 0 Before Instruction
Before Instruction WREG = OxA3
WREG = Oxi17 After Instruction
REG = 0xC2 WREG = 0x03
After Instruction
WREG = O0xD9
REG = 0xC2
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TSTFSZ

Test f, skip if 0

Syntax:
Operands:
Operation:
Status Affected:
Encoding:
Description:

Words:
Cycles:
Example:

[ labell TSTFSZ f

0<f<255

skipiff=0

None

[ 0011 | o011 | eeee [ egee |

If ' = 0, the next instruction, fetched
during the current instruction execution,
is discarded and an NOP is executed
making this a two-cycle instruction.

1
12

HERE TSTFSZ CNT
NZERO
ZERO

Before Instruction
PC = Address(HERE)

After Instruction

if CNT
PC

if CNT
PC

0x00,

Address (ZERO)
0x00,

Address (NZERO)

[ |

Exclusive OR Literal with

XORLW WREG
Syntax: [ label] XORLW k
Operands: 0<k<255
Operation: (WREG) .XOR. k —» (WREG)
Status Affected: z
Encoding: I 1011 ] 0100 l ik | kk}c?'
Description: The contents of WREG are XOR'ed
with the eight bit literal 'k'. The result is
placed in WREG.
Words: 1
Cycles: 1
Example: XORLW OxXAF
Before Instruction
WREG = 0xB5
After Instruction
WREG = O0x1A
XORWF Exclusive OR WREG with f
Syntax: [/fabel] XORWF f,d
Operands: 0<f<255
de [0,1]
Operation: (WREG) .XOR. (f) — (dest)
Status Affected: 2
Encoding: L 0000 | 1104 | eeee I ffff—l
Description: Exclusive OR the contents of WREG
with register 'f'. If 'd" is O the result is
stored in WREG. If 'd" is 1 the result is
stored back in the register 'f'.
Words: 1
Cycles: 1
Example: XORWF  REG, 1
Before Instruction
REG = OxAF
WREG = 0xB5
After Instruction
REG = Ox1A
WREG = 0xBS
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10.5.3 Aufbau eines Assembler-Files

Format des Quelltextes

Damit das Assemblerprogramm den Quelltext korrekt iibersetzen kann, mu8 dieser
bestimmten Vereinbarungen geniigen. Die Schreibweise der Befehle und Label gehort
genauso dazu wie die Einhaltung der vom Assembler verlangten Syntax bei arithmetischen
und logischen Operationen. Alle weiteren Erliuterungen beziehen sich ausschlieBlich auf
den PIC-ASM17-Assembler Version 1.08 der Firma Microchip Technology Inc., der dem
Buch in Form einer Diskette beiliegt.

Der Quelltext darf folgende Zeichen enthalten (mit Ausnahme des Kommentarfeldes, hier
sind alle Zeichen zuldssig):

- Buchstaben a...z (kein 31),
- Buchstaben A..Z,

- Ziffern 0...9,

- Sonderzeichen $, &, 7, ., .

Folgende Zeichen sind fiir Spezialzwecke reserviert:
¢ “ 4+ -5\ * () = und das Leerzeichen.

Grundsitzlich besteht jeder Quelltext aus einer Folge von Zeilen, die alle nach einem
bestimmten Muster aufgebaut sind:

[Label] Befehl [Operand] [Kommentar]

Eingeklammerte Felder [] kénnen bei bestimmten Zeilen fehlen. Die Bedeutung der
einzelnen Felder wird im folgenden beschrieben. :
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10.5.3.1 Beispiel fur ein Assemblerfile

list p=17c43, f=inhx32 ;Device name und Art des HEX-Codes,
;der erzeugt werden soll
include c:\pic\mplab\p17c43.inc ;Das File enthélt die Definition der vorgegeben Register

;im RAM, so dass man diese namentlich gleich
;ins Programm einbinden kann (MPLAB-Software)

;Fiir die PICMASTER-Software heisst der Befehl:
sinclude ”pl7cxx.inc”

; Definition von verschiedenen 8-bit-RAM-Adressen als Variable, die man
; dann hinterher unter dem definierten Namen ansprechen kann

wreg equ 0x0a
bsr equ 0x0f

addlhi equ

; Das eigentliche Programm beginnt nun
; Es beginnt bei der Adresse 0000 im ROM

goto start
org 0100 ; subl will man an der ROM-Adresse 0100 stehen haben
subl Befehll _sub

Befehl2_sub2

return ; Riicksprung
org 0018 ; start-Routine soll an der Adresse 0018 im ROM stehen
start Befehl 1 ; Kommentare ganz wichtig

Befehl 2

call subl ; Unterroutine sub 1 wird aufgerufen

Befehl n

end ; programmende
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10.5.3.2 Beispiel fur die Interruptbehandlung in einem Assemblerfile

Der PICI7C42 stellt fiir jeden der vier Interruptvektoren jeweils 8 Byte an Programmspeicher
zur Verfligung. Wenn die Interruptroutine liinger wird, muB sie an eine andere Steile im
Programmspeicher verschoben werden und miteinem Sprungbefehl angesprungen werden:

org 0000
reset goto start

org 0008
int_vec goto ext_int

org 0010
rtcc_vec retfie

org 0018
rt_vect inct zaehler, £

retfie

org 0020
peri_vec btfsc pir,irb

goto portb_int
btfsc pir,tbmt
goto senden

Start Hauptprogramm

Sprung in Interrupt-
routine

Dieser Interrupt wird
nicht benutzt, aus
Sicherheitsgrinden wird
eine Minimalroutine
eingebaut, die falsch
ausgelédéste Interrupts
abfangt.

Dieses Interrupt-
programm zahlt Impulse
am RT-Pin. Es verandert
kein Register.

Test auf Port B
Interrupt
gefunden
Test Sendepuffer
gefunden
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10.5.4 Einfuhrung in die Software MPLAB

Introduction

This chapter will give an overview of MPLAB IDE.

Highlights
In this chapter, we discuss:
e What is MPLAB IDE
* How MPLAB IDE Helps You

* MPLAB IDE — An Integrated Development Environment (IDE)
* MPLAB IDE Development Tools

What is MPLAB IDE

MPLAB IDE is a Windows®-based Integrated Development Environment
(IDE) for the Microchip Technology Incorporated PICmicro® microcontroller
(MCU) families. MPLAB IDE allows you to write, debug, and optimize
PICmicro MUC applications for firmware product designs. MPLAB IDE
includes a text editor, simulator, and project manager. MPLAB IDE also
supports the MPLAB-ICE and PICMASTER® emulators, PICSTART® Plus
and PRO MATE® I programmers, and other Microchip or third party
development system tools.

How MPLAB IDE Helps You

The organization of MPLAB IDE tools by function helps make pull-down
menus and customizable quick keys easy to find and use. MPLAB IDE tools
allow you to:

» Assemble, compile, and link source code

Debug the executable logic by watching program flow with the simulator,
or in real time with the MPLAB-ICE emulator

Make timing measurements

View variables in watch windows

Program firmware with PICSTART Plus or PRO MATE I

Find quick answers to questions from the MPLAB IDE on-line Help
and much more.

*
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MPLAB IDE - An Integrated Development
Environment (IDE)

MPLAB IDE is an easy-to-learn and use Integrated Development Environment
(IDE). The IDE provides firmware development engineers the flexibility to
develop and debug firmware for Microchip’s PICmicro MCU families. The
MPLAB IDE runs under Microsoft Windows 3.1x, Windows 95/98, Windows
NT, or Windows 2000.

Note: Not all hardware components that function under the MPLAB IDE,
such as emulators and device programmer, function under all oper-
ating systems. Refer to the user’s guide of the specific hardware
device for details.

MPLAB IDE provides functions that allow you to:
¢ Create and Edit Source Files
* Group Files into Projects
* Debug Source Code
» Debug Executable Logic Using the Simulator or Emulator(s)

The MPLAB IDE allows you to create and edit source code by providing you
with a full-featured text editor.

Further, you can easily debug source code with the aid of a Build Results
window that displays the errors found by the compiler, assembler, and linker
when generating executable files.

A Project Manager allows you to group source files, precompiled object files,
libraries, and linker script files into a project format.

The MPLAB IDE also provides feature-rich simulator and emulator
environments to debug the logic of executables. Some of the features are:

» A variety of windows allowing you to view the contents of all data and
program memory locations

» Source Code, Program Memory, and Absolute Listing windows allowing
you to view the source code and its assembly-level equivalent
separately and together (Absolute Listing)

* The ability to step through execution, or apply Break, Trace, Standard,
or Complex Trigger points
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MPLAB IDE Development Tools

The MPLAB IDE integrates several tools to provide a complete development
environment.

* MPLAB Project Manager

Use the Project Manager to create a project and work with the specific
files related to the project. When using a project, you can rebuild source
code and download it to the simulator or emulator with a single mouse
click.

* MPLAB Editor

Use the MPLAB Editor to create and edit text files such as source files,
code, and linker script files.

¢ MPLAB-ICD In-Circuit Debugger

The MPLAB-ICD In-Circuit Debugger is a powerful, low-cost develop-
ment and evaluation kit for the FLASH PIC16F87X MCU family.

* MPLAB-SIM Simulator

The software simulator models the instruction execution and I/O of the
PICmicro MCUs.

* MPLAB-ICE Emulator

The MPLAB-ICE emulator uses hardware to emulate PICmicro MCUs in
real time, either with or without a target system.

¢ MPASM Assembler/MPLINK Linker/MPLIB Librarian

The MPASM assembler allows source code to be assembled without
leaving MPLAB IDE. MPLINK creates the final application by linking relo-
catable modules from MPASM, MPLAB-C17, and MPLAB-C18. MPLIB
manages custom libraries for maximum code reuse.

* MPLAB-CXX C Compilers

The MPLAB-C17 and MPLAB-C18 C Compilers provide ANSI-based
high level source code solutions. Gomplex projects can use a combina-
tion of C and assembly source files to obtain the maximum benefits of
speed and maintainability.

» PRO MATE® Il and PICSTART® Plus Programmers

Develop code with the simulator or an emulator, assemble or compile it,
then use one of these tools to program devices. This can all be accom-
plished with MPLAB IDE. Although PRO MATE Il does not require
MPLAB IDE to operate, programming is easier using MPLAB IDE.

PICMASTER and PICMASTER-CE Emulators

These emulators use hardware to emulate PICmicro MCUs in real time,
either with or without a target system. MPLAB-ICE is the newest emula-
tor from Microchip.

¢ Third Party Tools

Many other companies have development tools for Microchip products
that work with MPLAB IDE. Consult the Microchip Third Parly Guide
(DS00104).
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10.5.5Beschreibung der Toolbarsvon MPLAB

Edit Toolbar

The Edit toolbar contains buttons that are commonly used when editing
source code.

Figure 7.82: Edit Toolbar

The default buttons are:

1. Change toolbar

2. File New

3. File Open

4. File Save

5. Cut

6. Copy

7. Paste

8. Print

9. Find

10. Repeat Last Find

11. Replace

12. Repeat Last Replace
13. Undo Edit

14. Indent

15. Unindent

16. Goto Line

17. Toggle Line Numbers
18. Help Contents
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Debug Toolbar

The Debug toolbar contains buttons that are commonly used when running
and debugging code.

AT TEA A .

1 2 3 4 5 6 7 8 9 10 M 12 13 U 15 16 17 18

Figure 7.83: DebugToolbar

The default buttons are:

Change toolbar
Run Program

Halt Program

Step Through Program
Step Over

Reset System
Change PC
Execute Opcode

9. New Watch Window
10. Modify Window

11. Break Point

12. Trace Point

13. Trigger

14. Clear All Breaks
15. Conditional Break
16. Halt Trace

17. System Reset

18. Help Release Notes

© NSO RAEOD=

Project Toolbar

The Project toolbar contains icons that are commonly used when running and
debugging code.

Figure 7.84: Project Toolbar
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The default buttons are:

Change toolbar
New Project
Open Project
Close Project
Save Project
Edit Project
Make Project
Build All

9. Build Node
10. Install Tools
11. Help

PN O~ ND =

User Defined Toolbar

The User Defined toolbar is intended to be customized to contain buttons that
meet the individual user’s needs.

9 10 112 13 14 15

Figure 7.85: User Defined Toolbar

It initially contains the following buttons:

Change Toolbar
Open Project
Save Project
Find
Cut
Copy
Paste
Save File
Run
. Halt
. Step
. Step Over
. Reset
. Program Memory Window
. File Registers Window
. Special Function Registers Window
. New Watch Window
. Make Project

© Nk WD~
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MPLAB IDE Status Bar

The Status Bar indicates such current information as cursor position,
development mode and device, and active toolbar.

IELn 0 Eal 2 | 2048 | B0 Mowhap NS [PIC1RCESE pebl W00 2dce BEDREm 0 Debug

Figure 7.86: Status Bar

. Typical . Result from Double
Title Entry Description Clicking
Line No., Column-Windows Ln 1 Col 1 |Displays current line number and column |Opens Goto Line Dialog
Open in file
2.00.00 MPLAB IDE Version Number No Action
Or, displays MPLAB IDE Version
Number when no windows are
open
Lines in File 72 Displays number of lines in current text [No Action
file
File Modified # Displays # Symbol if file has been No Action
changed since opening
Write/Read Only WR Displays Write/Read Only Status. Toggles between write and
WR = Editable File read only for files that you
RO = Read Only File have access to
Text Wrap No Wrap |Displays current wrap mode and wrap | Toggles between wrap and
column if text wrap is on no wrap
Example 1: NoWrap No Wrap
Example 2: WR 72 Wrap at Column 72
Useful for text files. Use Options >
Current Editor Modes to change wrap
column.
Insert/Strikeover INS Toggles typing mode between insert and | Toggles between INS and
strikeover OVR
INS = Insert Characters
OVR = Type over characters
Current Processor PIC16C61 |Displays the currently selected No Action
processor
Current Program Counter pc:0x5f Displays the current program counter Opens Change Program
Counter dialog
Current w Register Value W:0x00 Displays current w register value No Action
Status Bits ovZdcc |UpperCase=Set (1) No Action
Lower Case = Reset (0)
Global Break Enable Bk On Displays current status of Global Break |Toggles Global Break
Enable Enable On and Off
. Typical i Result from Double
Title Entry Description Clicking
Current Development Mode Sim Displays Current Development Mode. Displays Development
Examples: Mode Dialog
EO = Editor Only
Sim = Simulator — MPLAB-SIM
Si = Simulator — SIMICE
ICE = Emulator — MPLAB-ICE
Em = Emulator — PICMASTER emulator
Processor Frequency 4 MHz Displays current processor frequency Opens processor clock
dialog
Current Tool Bar Edit Displays current tool bar No Action
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10.5.6 Tutorial zur Software MPLAB

Introduction

This tutorial is intended to be a quick introduction to the MPLAB IDE user
interface. It should take about 1 to 2 hours to complete the Tutorial.

This is not intended to discuss all of the details of MPLAB IDE, only to provide
a beginning understanding so you can use MPLAB IDE right away.

Highlights
In this tutorial, you will learn about:

¢ Setting up the Development Mode
Creating a Simple New Project
Creating a Simple New Source File
Entering Source Code

Assembling the Source File

Running Your Program

Opening Other Windows for Debugging
Creating a Watch Window

Saving the Watch Window

¢ Setting a Break Point

In addition, there is an overview of other features to be discussed in later
chapters.

With the operation of MPLAB IDE provided by this tutorial, you should be able
to:

¢ Become familiar with the MPLAB IDE Desktop

* Create a new assembly source code file and enter it into a new project
for the PIC16F84

Identify and correct simple errors

Run the built in simulator

Set break points

Create Watch windows

Become familiar with the various debugging windows
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Setting up the Development Mode

The previous chapter discussed how to install MPLAB IDE. Now you will begin
setting up the application.

The MPLAB IDE desktop (Figure 3.1) contains the following major elements:

1. A menu across the top line

2. A toolbar below the menu

3. A workspace in which various files, windows, and dialogs can be
displayed

4. A status bar at the bottom

Notice that the status bar includes information about how the system is

currently configured. We’'ll cover some of these features in more detail later.
For now, let's see how to set the development mode.

ey’ 101 1112122 7

1. Menu

2. Toolbar
3. Workspace

L

4. Status Bar

\ ;

Figure 3.1: MPLAB IDE Desktop

The development mode sets which tool, if any, will execute code. For this
tutorial we will use MPLAB-SIM, the software simulator. Later you may switch
to one of the emulator operations if you have an emulator. Operation will be
similar. “Editor Only” mode does not allow code execution, and is mainly
useful if you have not installed the simulator, do not have an emulator, and are
just creating code to program a PICmicro microcontroller (MCU).
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Select the Options > Development Mode menu item and click the Tools tab to
select the development tool and processor for your project.

Development Mode : : : : : : e
. :Euﬁfigﬁratiﬁn :~| F"nufﬂr ] ] :1 Piﬂ!ﬂ: ] ] :.] Erﬂaﬁ [lﬁtiuﬁ:ﬂ ]
Tool: ] - ] Elock "] .

. Hone [Lditor Dnly] Processor | PIC1GFS4
Mot all peripherals have support

_ for simulation.
AR gl o Bl Senal 170 iz not simulated.

. PIEMASTER Emulator Click "Details” for additional
ek e nE infarmation on PICTGF24.

. MPILAB-ILD Debuagger ivreiie I
. . ETaTE l i l EHRD l

Figure 3.2: Development Mode Tools Dialog

MPLAB IDE is a constantly evolving product, so there may be subtle
differences between what you see and the picture here. Select MPLAB-SIM
Simulator and choose the PIC16F84 from the pull down list of available
processors supported by the simulator. Click OK. The simulator will initialize
and you should see “PIC16F84” and “Sim” in the status bar on the bottom of
the MPLAB IDE desktop. You are now in simulator mode for the PIC16F84
device.

Creating a Simple New Project

The simulator runs from the same file (a hex file) that can be programmed into
the PICmicro MCU. For the simulator to run you must first create a source
code file and successfully assemble the source code.

The assembler produces, among other things, a hex file. This file has the file
extension .HEX. In this tutorial the file will be named tutor84.hex. Later
this file can be loaded directly into a device programmer without using the
assembler or an MPLAB IDE project. This file can also be loaded by most
other third party programmers.

Select File > New from the menu and you will see a dialog that looks like
Figure 3.3.
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Create Project .

Iy op -
Would would like lo create anew

Figure 3.3: Create Project Dialog

Click Yes, and a standard Windows browsing dialog will appear (Figure 3.4).
In this dialog, indicate the location where you want your project stored.
Remember where you put it. You'll need this information later. This tutorial
uses a directory in ¢: \Program Files\MPLAB and creates the project file
hamed tutor84.pjt.

“PJT” is a standard suffix for MPLAB IDE project files. The prefix of the project

file name, in this case tutor84, will become a default prefix for many of the
files that MPLAB IDE will use or create for this tutorial.

&4 progra™1
£35) mplab

(] example

| [ help
i =3 template

Figure 3.4: New Project Dialog

Using the mouse to click OK will bring you to the Edit Project Dialog
(Figure 3.5).

The simulator, programmers, and emulator systems that work with MPLAB
IDE use a hex file created by assembling, compiling, and/or linking source
code. Several different tools can create hex files, and these tools are part of
each project. Projects give you flexibility to describe how the application will
be built and which software tools will be used to create the . HEX file. We will
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not get into these details in this tutorial, but as you need these features you
will be using the Node Properties to set these. See Chapter 4 for information
on more complex projects.

Edit Project

Target Filename

Include Path

P

Figure 3.5: Edit Project Dialog — Node Properties Enabled

Notice that the target file name of the Edit Project dialog has been filled in for
you. It uses the development mode that we set previously and defaults to
using the Microchip language tool suite.

In addition, the default language suite, paths, and nodes for all projects are
set selecting Options > Environment Setup and clicking the Projects tab.
These defaults appear in the Edit Project dialog for all new projects.

In the Project Files window, you will find tutor8g4 . [hex]. Highlighting this
name will cause the Node Properties button to become usable.

Before we do anything else, we must tell MPLAB IDE how to create the hex
file. Do this by clicking the Node Properties button. The Node Properties
dialog will appear (Figure 3.6).
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| |Define
 |Hex Format il INHXBM & INHX8S5 F INHx32
. |Error File # On # Off
- |List File & 0On & Off
_|Cross-reference File [ On B Off
| \warning level # all # warnterr & err
Case sensitivity 15‘ On 3 Off
. Macro expansion  0On B Off
" \Default radix ¥ HEX = DEC
- |Tab size & on

 Commandiine . L L 8

on 'wi /c+ fm+ frhex /p16F84 - ;

. ... _ @ @ @@

Figure 3.6: Node Properties Dialog

This dialog contains all of the default settings for the language tool shown in
the upper right of the dialog (in this case MPASM). In the simplest form, a
project contains a hex file created from one assembly source file. This is the
default as the Node Properties dialog appeatrs.

You can see that there are a lot of rows and columns on this dialog. Each row
usually corresponds to a “switch,” those things that are often set on the
command line when the tool is invoked. In fact, the setting of these switches is
reflected in the Command Line window near the bottom. This is the actual
command line that will be issued to MPASM when it is invoked from MPLAB
IDE.

For now you can use the default settings for all other entries, but as you
become more familiar with building an application, you will probably find that
you’ll want to change some of these.

Clicking OK will apply these defaults, bring you back to the Edit Project dialog
and enable the Add Node button (Figure 3.7).
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Edit Praject

. Tamet Hlename

| Include Path

| Libram Path

' Linker Script Path-

| Add Node...
el
| EipasENEe
L

MNode Properties. . |

Figure 3.7: Edit Project Dialog — Add Node Enabled

Click Add Node. You will see the standard windows browse dialog
(Figure 3.8), and the working directory will be the same as the project
directory. Enter the file name tutorg84.asm, and click OK.

. Fil&ﬂam&: - - - - . - - — : "-:: - - -
' example?_aszm :
idasm16._asm - 23 progra™1
idasm1 7 asm - ey lab
mul8x8_asm 1l éﬁ mpia
readme. asm 1 | L enample
sample. azm 1l ] help

sampobj.asm = [ template
tutor. asm__ SR

. List Hles of lype

!Suume files ['c: asm] ‘Fi - IQ::: STI -

Figure 3.8: Add Node Dialog
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Creating a Simple New Source File

Click once in the blank space of the empty file window that has been created
for you. It is probably titled “Untitled.” This gives the window “focus.” Use the
File > Save As... menu option and save the empty file as tutor84.asm.

When the standard browse dialog opens, you will find tutor84 .asm located

in the current working directory of the project. Enter the file name and click
OK.

File Name Hieptones ok

idasm b asm £q e

idasm|7 asm = pe
mul8xd asm " progra™]

readme. azm {3 mplab

Lancel

Help

sample asm f;l example :
sampob) asm [ help I- UHEL format

tutor asm 23 oldfirm Iv Eeep backup
tutor8d. asm

List Files of Type Diives Network ..

lﬁuun::e fles [*.c;*.asm] "’] l B 'I

Figure 3.10: Save Source File

You will now be presented with the MPLAB IDE desktop and the empty file
window, but the name of the file window will reflect its new name.

The name of the source file and the name of the project (tutors4 in this
tutorial) must be the same in this kind of project. If you change the name of
the source file, you must also change the name of the project to match. Other
projects that use the linker allow the output file name to be different from the
input file (Section 4.6 provides a tutorial on creating projects using the linker).

Note: For a single source file project, MPASM creates its output hex file
with the same name as the source file. The project name, hex file,
and source file MUST have the same name.
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Entering Source Code

Use the mouse to locate the cursor at the beginning of the tutorg84.asm
empty file window, and enter the following text, exactly as written on each line.
You don’t have to enter the comments, the text following the semicolons.

list p=16£84
include <pl6F84.inc>
cl equ 0x0c ; Set temp variable counter ¢l at address 0x0c
org 0x00 ; Set program memory base at reset vector 0x00
reset
goto start ; Go to start of the main program
org 0x04 ; Set program memory base to beginning of user code
start
movlw 0x09 ; Initialize counter to arbitrary value greater than zero
movwf cl ; Store value in temp variable a defined above
loop
incfsz c¢l1,F ; Increment counter, place results in file register
goto loop ; Loop until counter overflows
goto bug ; When counter overflows, got to start to re-initialize
end

This code is a very simple program that increments a counter and resets to a
predetermined value when the counter rolls over to zero.

All labels start in the first column, and the last line has an end directive. Refer
to the MPASM with MPLINK and MPLIB User’s Guide for more information
about directives. The PICmicro MCU data sheets contain full information
about instructions along with examples of their use.

Save the file by using the File > Save menu item.
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Assembling the Source File

Assembling the file can be accomplished in several ways. The method
described here uses the Project > Build All menu item. This will execute the
MPASM assembler in the background using the defaults saved with the
project as noted before. Once the assembly process is complete, the Build
Results window will appear (Figure 3.11).

L e |
Building TUTORSH.HEX... -

Compiling TUTORSY.ASM:
Command line: "C:\MCHP\MPLAB\MPASM.EXE /fe+ /1+ /x- /uB /et /m+ /rhex /p16F84 /q C:\
EFFor[113]  C:\TEMP\TUTORIAL\TUTORS4.ASM 17 . Syibel net previcusly defined (bug)

MPLAB is unable to find output file "TUTORSY.HEX".

Build failed.

Figure 3.11: Build Results Window — Build Failed

You have intentionally entered at least one error if you entered the code as
written in Section 3.6. The last goto in the program references a nonexistent
label called bug. Since this label has not been defined before, the assembler
reports an error. You may have other errors as well.

Using the mouse, double click on the error message. This will bring the cursor
to the line in the source code that contains the error. Change bug to start.
Use the Build Results window to help find the errors, and repair any other

bugs in your source code. Reassemble by executing the Project > Build All
menu function. This process may take a couple of iterations.

to disk.

Note: Whenever you rebuild a project all of your source files will be saved |

When you’ve fixed all problems in the source code, the Build Results window
will display “Build completed successfully” (Figure 3.12). You now have a
complete project that can be executed using the simulator.

ﬁ_lild Results z ; o - [Of =]
Building TUTORS84.HEX. .. =

Compiling TUTORE4.ASH:
Command line: "C:\MCHP\MPLAB\MPASM.EXE /e+ /1+ /x- Ju® /Jc+ /m+ /rhex /pl16F84

Euild completed successfully.

Figure 3.12: Build Results Window — Build Successful
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Running Your Program

Use the Debug > Run > Reset to initialize the system. The program counter
will be reset to zero, which is the reset vector on the PIC16F84. The source
code line at this address may be highlighted with a dark bar. Also, you may
notice that PC is set to 0x00 in the status bar at the bottom of MPLAB IDE.

Use the Debug > Run > Step menu item. This causes the program counter to
advance to the next instruction location. The dark bar will follow the source
code and the program counter displayed in the status bar should advance to
“pc:0x04.”
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end

Figure 3.13: Debug > Run > Step Menu Item

You may notice as you execute the Debug > Run > Step menu item that there
is text on the right side of the menu item that says <F7>. This stands for
“function key seven” on your keyboard. Many MPLAB IDE functions are
assigned to “shortcut keys.” These keys have the same affect as executing
the menu item itself. Press <F7> a few times and watch the program counter
and dark bar advance through the program.

Execute the Debug > Run > Run menu item or press <F9> to start the
program running from the current location counter. The status bar will change
colors indicating the program is executing instructions. None of the other
fields on the status bar will be updated until the program is halted.

Stop the program by executing the Debug > Run > Halt menu item or by
pressing <F5>. The status bar will change back to its original color, and the
current program counter and other status information will be updated.

Another way to execute functions is to use the tool bar at the top of the
screen. If you place the cursor over the items in the tool bar, you can see the
name of the function in the status bar at the bottom. The left button is a
standard Change Tool bar button that allows you to scroll through the
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available toolbars. Toolbars can be customized (see Section 7.8.5.1.4). On
the debug toolbar, the green light is equivalent to <F9> (Run) and the red light
is the same as <F5> (Halt).

Opening Other Windows for Debugging

There are many ways to look at your program and its execution using MPLAB
IDE. For example, this program is intended to increment a temporary counter,
but how do you know for sure that is happening? One way is to open and
inspect the file register window. Do this by executing the Window > File
Registers menu item. A small window with all of the file registers, or RAM, of
the PIC16F84 will appear.

Press <F7> (Execute Single-Step) a few times and watch the values update in
the file register window. We put the counter variable at address location 0x0C.
As the temporary counter is incremented, this is reflected in the file register
window. File registers change colors when their value changes so that they
can easily be noticed on inspection. However, in very complex programs,
many values may change, making it difficult to focus on one or two variables.
This problem can be solved by using a Watch window.

Using a Watch Window

MPLAB IDE allows the contents of file registers to be monitored through a
Watch window.

Creating a Watch Window

To create a Watch window, select Window > Watch Window > New Watch
Window. If you have already created a Watch window and saved it to disk,
select Window > Watch Window > Load Watch Window. Select the Watch
window file to load and click OK, or double click the desired file.

The Add Watch Symbol dialog will appear (Figure 3.14).

Add Watch Symbol B

_ Delete

Cloze

Properhies

Help

Figure 3.14: Add Watch Symbol Dialog
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Typing ‘c1’ in the symbol name box will cause the list to scroll to the c1
symbol. Highlight the symbol and click the Add button, then click the Close
button. You will be left with the Watch window on your MPLAB IDE deskiop
(Figure 3.15) displaying the current value of the temporary counter value ‘c1.

hddress Symbol Ualue
ac ¢l H o’

Figure 3.15: Watch Window

You can display the contents of the Watch window with or without line
numbers. To change this setting, select Toggle Line Numbers from the system
menu inside the Watch window.

Press <F7> to single step the program a few times and notice that as the
counter value is incremented, the display is updated in the Watch window. If
you've left the file register window open, it will update as well.

Saving the Watch Window

You can save the Watch window and its settings by selecting Window > Watch
Window > Save Active Watch from the MPLAB IDE menu or by selecting
Save Waich from the system menu inside the Watch window. (The system
menu button is located in the upper left-hand corner of the Watch window.
Clicking this button once will cause the menu underneath to cascade down.)
Choose a name and click OK.

Ul new. wat
|| | walch_T.wat

i:g example
7] help
21 oldfirm

i Watch 1l.'d’indi:lﬂ_nl.! Files[*:®}| |¢

Figure 3.16: Save Watch Window Dialog
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The window’s open or closed status and location on the screen is saved with
the project so the next time you open your project, your Watch windows will be
restored as well.

Editing the Watch Window

You can also edit the Watch windows after you've created them.

Use either the Window > Watch Window submenu or the system menu inside
the Watch window to edit the information in the Watch window.

Add a symbolto  Select Window > Waich Window > Add to Active Watch
the Watch window from the MPLAB IDE menu or select Add Watch from
the system menu inside the Watch window.

Delete a symbol  Click on the symbol in the Watch window, then select
from the Watch Delete Watch from the system menu.

window

Change the dis- Select Window > Waich Window > Edit Active Watch
play format of from the MPLAB IDE menu or select Edit Waich from
symbols the system menu inside the Watch window. Then, click

Properties. The Properties dialog allows you to select
the format, size, byte order, and display bits for display
in the Watch Window.
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Setting a Break Point

Press <F5> (Debug > Run > Half) to make sure that the simulator processor is
halted. Click in the source code window on the line immediately after the
start label that says movlw 0x09. Click the right mouse button and a small
shortcut menu will appear (Figure 3.17).

 Break Paint(s)

 TracePoint(s)
- Trigger Pointis) |

Figure 3.17: Right Mouse Button Pop-up Menu

Select the Break Point(s) menu item and the menu will disappear and the line
where the cursor was located will change colors, indicating that a break point
has been set at that location.

Press <F6> or execute the Debug > Run > Reset menu item to reset the
system. Then run the system by pressing <F9>. The program will run and
then halt at the instruction just after the break point. ‘c1’, as displayed in either
the Watch window or the file register window (if one is still open), will reflect
the reset status of zero; stepping once will execute the code and ‘c1’ will
reflect a value of 0x09. Press <F9> a few times and notice the status bar
change color while running, and will change again when the processor halts.

Note: If execution doesn’t halt at the break point, select Options > Devel-
opment Mode and click the Break Options tab. Make sure that
Global Break Enable is selected (check marked).

Summary

This tutorial has shown you how to:

set up a new project

create and enter a source file into a project
assemble code

run your code using the simulator

set break points and single step your code
watch variables in your code

Once you are comfortable with the topics introduced here, you should look at
the next section for more information on MPLAB IDE.
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Some hints and tips:

Break Points — You can set break points in the Window > Program Memory
window, in the source file window (in this case tutor84.asm), or in the

Window > Absolute Listing window.

Source Files — Use the Window > Project Window to bring up a list of your
source files. You can double click on the file name here to bring up that file in
the editor.

MPASM Errors — If MPASM gives you an error, double click on that error in
the error window to go to the error in the source code. If you've got multiple
errors, always choose the first error. Often one error will cause subsequent
errors and fixing the first one may fix them all.

Configuration Bits and Processor Mode — Configuration bits in the source
file will not set the mode of the processor for the simulator (or emulators). For
instance, the Watch Dog Timer Enable configuration bit can be set so that
when you program a device, the Watch Dog Timer (WDT) will be turned on.
You will also need to select Options > Development Mode and click the
Configuration tab to enable the WDT for the simulator or emulator. This
allows you to debug with it on or off without changing your source code. Use
the Options > Development Mode Configuration tab to set the processor
mode as well. Even though you can set these bits in your MPASM or MPLAB-
CXX source file, MPLAB IDE does not autematically change modes.

Options — Go to Options > Environment Setup and click the General tab to
do the following:

* Change the screen font or font size

s Position the tool bar on the side or bottom of the screen
* Modify the tool bar

¢ Change the number of characters displayed for labels

Betfore you close the dialog, click the Key Mappings tab to map European
Keys to MPLAB IDE functions and special ASCII characters.

Map Files — Go to Project > Edit Project dialog and change MPASM’s Node
Properties to produce a MAP file named tutor84 .map. After you've built the
project, look at tutor84 .map to see build information.

Grayed Out Menus — If you find menus “grayed out,” check to make sure that
you haven’t somehow entered the Editor Only mode. If you’re sure everything
is set up correctly, try exiting MPLAB IDE and restarting the program.
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